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CHAPTER
ONE

COURSE INTRODUCTION

1.1 Foreword

Welcome to our course! We will be showing you how to use QGIS easily and efficiently. If you are new to GIS,
we will tell you what you need to get started. If you are an experienced user, you will see how QGIS fulfills all the
functions you expect from a GIS program, and more!

1.1.1 Why QGIS?

As information becomes increasingly spatially aware, there is no shortage of tools able to fulfill some or all commonly
used GIS functions. Why should anyone be using QGIS over some other GIS software package?

Here are only some of the reasons:

* It’s free, as in lunch. Installing and using the QGIS program costs you a grand total of zero money. No initial
fee, no recurring fee, nothing.

e It’s free, as in liberty. If you need extra functionality in QGIS, you can do more than just hope it will be included
in the next release. You can sponsor the development of a feature, or add it yourself if you are familiar with
programming.

* It’s constantly developing. Because anyone can add new features and improve on existing ones, QGIS never
stagnates. The development of a new tool can happen as quickly as you need it to.

* Extensive help and documentation is available. If you’re stuck with anything, you can turn to the extensive
documentation, your fellow QGIS users, or even the developers.

* Cross-platform. QGIS can be installed on macOS, Windows and Linux.

Now that you know why you want to use QGIS, these exercises will make you know how.

1.1.2 Background

In 2008 we launched the Gentle Introduction to GIS, a completely free, open content resource for people who want to
learn about GIS without being overloaded with jargon and new terminology. It was sponsored by the South African
government and has been a phenomenal success, with people all over the world writing to us to tell us how they are
using the materials to run University Training Courses, teach themselves GIS and so on. The Gentle Introduction is not
a software tutorial, but rather aims to be a generic text (although we used QGIS in all examples) for someone learning
about GIS. There is also the QGIS manual which provides a detailed functional overview of the QGIS application.
However, it is not structured as a tutorial, but rather as a reference guide. At Linfiniti Consulting CC. we frequently
run training courses and have realised that a third resource is needed - one that leads the reader sequentially through
learning the key aspects of QGIS in a trainer-trainee format - which prompted us to produce this work.
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This training manual is intended to provide all the materials needed to run a 5 day course on QGIS, PostgreSQL and
PostGIS. The course is structured with content to suit novice, intermediate and advanced users alike and has many
exercises complete with annotated answers throughout the text.

1.1.3 License

@060

The Free Quantum GIS Training Manual by Linfiniti Consulting CC. is based on an earlier version from Linfiniti and
is licensed under a Creative Commons Attribution 4.0 International. Permissions beyond the scope of this license
may be available at below.

We have published this QGIS training manual under a liberal license that allows you to freely copy, modify and
redistribute this work. A complete copy of the license is available at the end of this document. In simple terms, the
usage guidelines are as follows:

* You may not represent this work as your own work, or remove any authorship text or credits from this work.

* You may not redistribute this work under more restrictive permissions than those under which it was provided
to you.

* If you add a substantive portion to the work and contribute it back to the project (at least one complete module)
you may add your name to the end of the authors list for this document (which will appear on the front page)

* If you contribute minor changes and corrections you may add yourself to the contributors list below.

* If you translate this document in its entirety, you may add your name to the authors list in the form “Translated
by Joe Bloggs”.

* If you sponsor a module or lesson, you may request the author to include an acknowledgement in the beginning
of each lesson contributed, e.g.:

Note: This lesson was sponsored by MegaCorp.

¢ If you are unsure about what you may do under this license, please contact us at office@linfiniti.com and we
will advise you if what you intend doing is acceptable.

* If you publish this work under a self publishing site such as https://www.lulu.com we request that you donate
the profits to the QGIS project.

* You may not commercialise this work, except with the expressed permission of the authors. To be clear, by
commercialisation we mean that you may not sell for profit, create commercial derivative works (e.g. selling
content for use as articles in a magazine). The exception to this is if all the profits are given to the QGIS project.
You may (and we encourage you to do so) use this work as a text book when conducting training courses, even
if the course itself is commercial in nature. In other words, you are welcome to make money by running a
training course that uses this work as a text book, but you may not profit off the sales of the book itself - all
such profits should be contributed back to QGIS.
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1.1.4 Sponsoring Chapters
This work is by no means a complete treatise on all the things you can do with QGIS and we encourage others to add
new materials to fill any gaps. Linfiniti Consulting CC. can also create additional materials for you as a commercial

service, with the understanding that all such works produced should become part of the core content and be published
under the same license.

1.1.5 Authors

* Riidiger Thiede - Rudi has written the QGIS instructional materials and parts of the PostGIS materials.

* Tim Sutton (tim@kartoza.com) - Tim has overseen and guided the project and co-authored the PostgreSQL
and PostGIS parts.

* Horst Diister (horst.duester@kappasys.ch ) - Horst co-authored the PostgreSQL and PostGIS parts

» Marcelle Sutton - Marcelle provided proof-reading and editorial advice during the creation of this work.

1.1.6 Individual Contributors

Your name here!

1.1.7 Sponsors

» Cape Peninsula University of Technology

1.1.8 Source files and Issue reports

The source of this document is available at GitHub QGIS Documentation repository. Consult GitHub.com for in-
structions on how to use the git version control system.

Despite our efforts, you could find some errors or miss some information while following this training. Please report
them at https://github.com/qgis/QGIS-Documentation/issues.

1.1.9 Latest Version

You can always obtain the latest version of this document by visiting the online version which is part of the QGIS
documentation website (https://www.qgis.org/resources/hub/#documentation).

Note: The documentation website contains links to both online and PDF versions of the Training manual and other
parts of the QGIS documentation.
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1.2 About the exercises

Now that you know why you want to use QGIS, we can show you how.

Warning: This course includes instructions on adding, deleting and altering GIS datasets. We have provided
training datasets for this purpose. Before using the techniques described here on your own data, always ensure
you have proper backups!

1.2.1 How to use this tutorial

Any text that looks like this refers to something that you can see in the QGIS user interface.
Text that looks » like » this directs you through menus.

This kind of text refers to something you can type, such as a command.
This/kind/of.text refers to a path or filename.

This+That refers to a keyboard shortcut comprised of two buttons.

1.2.2 Tiered course objectives

This course caters to different user experience levels. Depending on which category you consider yourself to be in,
you can expect a different set of course outcomes. Each category contains information that is essential for the next
one, so it’s important to do all exercises that are at or below your level of experience.

(Basic level) Basic
In this category, the course assumes that you have little or no prior experience with theoretical GIS knowledge or the
operation of GIS software.

Limited theoretical background will be provided to explain the purpose of an action you will be performing in the
program, but the emphasis is on learning by doing.

When you complete the course, you will have a better concept of the possibilities of GIS, and how to harness their
power via QGIS.

(Moderate level) Intermediate

In this category, it is assumed that you have working knowledge and experience of the everyday uses of GIS software.

Building on the instructions for the beginner level will provide you with familiar ground, as well as to make you aware
of the cases where QGIS does things slightly differently from other software you may be used to. You will also learn
how to use analysis functions in QGIS.

When you complete the course, you should be comfortable with using QGIS for all of the functions you usually need
for everyday use.
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(Advanced level) Advanced
In this category, the assumption is that you are experienced with GIS software, have knowledge of and experience
with spatial databases, using data on a remote server, perhaps writing scripts for analysis purposes, etc.

Building on the instructions for the other two levels will familiarize you with the approach that the QGIS interface
follows, and will ensure that you know how to access the basic functions that you need. You will also be shown how
to make use of the QGIS plugin system, database access, and so on.

When you complete the course, you should be well-acquainted with the everyday operation of QGIS, as well as its
more advanced functions.

1.2.3 Data

The sample data that accompanies this resource is freely available and comes from the following sources:
« Streets and Places datasets from OpenStreetMap
¢ Property boundaries (urban and rural), water bodies from NGI
* SRTM DEM from the CGIAR CSI

Download the prepared dataset from the Training data repository and unzip the file. All the necessary data are
provided in the exercise_data folder.

If you are an instructor, and would like to use more relevant data, you will find instructions for creating local data in
the Preparing Exercise Data appendix.
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CHAPTER
TWO

MODULE: CREATING AND EXPLORING A BASIC MAP

In this module, you will create a basic map which will be used later as a basis for further demonstrations of QGIS
functionality.

2.1 Lesson: An Overview of the Interface
We will explore the QGIS user interface so that you are familiar with the menus, toolbars, map canvas and layers list

that form the basic structure of the interface.

The goal for this lesson: To understand the basics of the QGIS user interface.

2.1.1 Try Yourself: The Basics

*Basic Map - QGIS 0c62abed96 [tm]

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

BERR @*LPrsHNPP R LR e S-E-%EE 2:';"9
g = . ® B

QAN e s

Layers EE)
vAeTE AL
d

v/ roads o

BNSDHS

Layers Erﬂ@
Type to locate (Ctrl+K |]\egendentnesmm0ved Coordinate 20.3420.-33.9989 | % Scale 1:32869 - | @ Magnifier| 100% < | Rotation |0.0° % v Render @ EPSG:4326 @

The elements identified in the figure above are:
1. Layers List / Browser Panel
2. Toolbars

3. Map canvas
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4. Status bar
5. Side Toolbar

6. Locator bar

The Layers List

In the Layers list, you can see a list, at any time, of all the layers available to you.

Expanding collapsed items (by clicking the arrow or plus symbol beside them) will provide you with more information
on the layer’s current appearance.

Hovering over the layer will give you some basic information: layer name, type of geometry, coordinate reference
system and the complete path of the location on your device.

Right-clicking on a layer will give you a menu with lots of extra options. You will be using some of them before long,
so take a look around!

Note: A vector layer is a dataset, usually of a specific kind of object, such as roads, trees, etc. A vector layer can
consist of either points, lines or polygons.

The Browser Panel

The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can have access to common
vector files (e.g. ESRI Shapefile or Maplnfo files), databases (e.g. PostGIS, Oracle, SpatiaLite, GeoPackage or MS
SQL Server) and WMS/WES connections. You can also view your GRASS data.

If you have saved a project, the Browser Panel will also give you quick access to all the layers stored in the same path
of the project file under in the = Project Home item.
Moreover, you can set one or more folder as Favorites: search under your path and once you have found the folder,

right click on it and click on Add as a Favorite. Youshould then be able to see your folder in the Favorites
item.

Tip: It can happen that the folders added to Favorite item have a really long name: don’t worry right-click on the
path and choose Rename Favorite... tosetanother name.

Toolbars

Your most often used sets of tools can be turned into toolbars for basic access. For example, the Project toolbar
allows you to save, load, print, and start a new project. You can easily customize the interface to see only the tools
you use most often, adding or removing toolbars as necessary via the View » Toolbars menu.

Even if they are not visible in a toolbar, all of your tools will remain accessible via the menus. For example, if you
remove the Project toolbar (which contains the Save button), you can still save your map by clicking on the Project
menu and then clicking on Save.
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The Map Canvas
This is where the map itself is displayed and where layers are loaded. In the map canvas you can interact with the

visible layers: zoom in/out, move the map, select features and many other operations that we will deeply see in the
next sections.

The Status Bar

Shows you information about the current map. Also allows you to adjust the map scale, the map rotation and see the
mouse cursor’s coordinates on the map.

The Side Toolbar

By default the Side toolbar contains the buttons to load the layer and all the buttons to create a new layer. But
remember that you can move all the toolbars wherever it is more comfortable for you.

The Locator Bar

Within this bar you can access to almost all the objects of QGIS: layers, layer features, algorithms, spatial bookmarks,
etc. Check all the different options in the locator_options section of the QGIS User Manual.

Tip: With the shortcut Ct r1+K you can easily access the bar.

2.1.2 Try Yourself: 1

Try to identify the four elements listed above on your own screen, without referring to the diagram above. See if you
can identify their names and functions. You will become more familiar with these elements as you use them in the
coming days.

Answer

Refer back to the image showing the interface layout and check that you remember the names and functions of the
screen elements.

2.1.3 Try Yourself: 2

Try to find each of these tools on your screen. What is their purpose?

=]
1. =5

2 50
3. [N

4. BRender

[—]

5.

Note: If any of these tools is not visible on the screen, try enabling some toolbars that are currently hidden. Also
keep in mind that if there isn’t enough space on the screen, a toolbar may be shortened by hiding some of its tools.
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You can see the hidden tools by clicking on the double right arrow button in any such collapsed toolbar. You can see
a tooltip with the name of any tool by holding your mouse over the tool for a while.

Answer

1. Save as
Zoom to layer(s)
Invert selection

Rendering on/off

A

Measure line

2.1.4 What’s Next?

Now that you are familiar with the basics of the QGIS interface, in the next lesson we will see how to load some
common data types.

2.2 Lesson: Adding your first layers

We will start the application, and create a basic map to use for examples and exercises.

The goal for this lesson: To get started with an example map.

Note: Before starting this exercise, QGIS must be installed on your computer. Also, you should have downloaded
the sample data to use.

Launch QGIS from its desktop shortcut, menu item, etc., depending on how you configured its installation.

Note: The screenshots for this course were taken in QGIS 3.4 running on Linux. Depending on your setup, the
screens you encounter may well appear somewhat different. However, all the same buttons will still be available, and
the instructions will work on any OS. You will need QGIS 3.4 (the latest version at time of writing) to use this course.

Let’s get started right away!

2.2.1 Follow Along: Prepare a map

1. Open QGIS. You will have a new, blank map.
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untitled Project - QGIS [new] <
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2. The Data Source Manager dialog allows you to choose the data to load depending on the data type. We'll use
it to load our dataset: click the ‘! Open Data Source Manager o,

If you can’t find the icon, check that the Data Source Manager toolbar is enabled in the View » Toolbars menu.

Untitled Project - QGIS [new]
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help

DEBRRRY Qe sp AP (YL~ T # Z m-o [0
Yol W = ® 2

©®  Recent Projects

@ WMS/WMTS

Data Source Manager | Browser
Browser
QYo
~ 7 Favorites
v [ /media/TRAVAIL/2019/Controle

- ¢ Vector

Raster
» @ xvzTiles -

® wes
@ wFs
© ows

» 6 Home
Y/ =)
2% Mesh
L] » @ GeoPackage

¢ Delimited Text / spatiaLite

@ ArcGisMapServer @ Postals
@ ArcGisFeatureserver S Geopackage » mssqL
st GeoNode @ pB2
#,, SpatiaLite » @ WMS/WMTS
» @ XYZTiles
4 PostaresQL & wes
v WFS
» © ows
ArcGisMapserver
& ArcGisFeatureserver
i GeoNode
Layers & WA virtual Layer *
“a=sv e -
& wms/wmts
& wes
a WFS
&3 ArcGis Map Server
ArCGIS Feature
J# server
4 GeoNode
Q Type to locate (Ctrl+K) Ready Coordinate ¥ scle 11 ~| @ Magnifier | 100% | Rotation |00° 2|V Render @ EPSG4326 @

3. Load the protected_areas. shp vector dataset:

1. Click on the Vector tab.

2. Enable the - ® File source type.

3. Press the ... button next to Vector Dataset(s).
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4. Select the exercise_data/shapefile/protected_areas. shp file in your training direc-
tory.

5. Click Open. You will see the original dialog, with the file path filled in.

Data Source Manager | Vector

B Browser Source Type
\/ Vector

* Raster

(@ File ( Directory (' Database (' Protocol: HTTP(S), cloud, etc.

, Encoding System -
e F Mesh

_. Source
* Delimited Text

\lﬂ GeoPack Vector Dataset(s) 'exercise_data/shapefile/protected areas.shp

4 GeoPackage

;f:_ Spatialite
* PostgreSQL
* MS5QL

082, DB2

m Virtual Layer

!Ea WMS/WMTS
5@; WCs
g WFS
ArcGIS Map
server

ArcGIS Feature
Server @Help < Add * Close

6. Click Add here as well. The data you specified will now load: you can see a protected_areas item
in the Layers panel (bottom left) with its features shown in the main map canvas.
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*Untitled Project - QGIS [new] =

Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
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@ GeoPackage
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) WFS
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Congratulations! You now have a basic map. Now would be a good time to save your work.

=]
1. Click on the Save As button: =54

2. Save the map under a solut ion folder next to exercise_data and call it basic_map.qgz.

2.2.2

Try Yourself:

Repeat the steps above to add the places.shp and rivers.shp layers from the same folder
(exercise_data/shapefile) to the map.

Answer

In the main area of the dialog you should see many shapes with different colors. Each shape belongs to a layer you
can identify by its color in the left panel (your colors may be different from the ones in Fig. 2.1 below):

2.2. Lesson: Adding your first layers 15
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basic_map - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help
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Fig. 2.1: A basic map

223 Follow Along: Loading vector data from a GeoPackage Database

Databases allow you to store a large volume of associated data in one file. You may already be familiar with a
database management system (DBMS) such as Libreoffice Base or MS Access. GIS applications can also make use
of databases. GIS-specific DBMSes (such as PostGIS) have extra functions, because they need to handle spatial data.

The GeoPackage open format is a container that allows you to store GIS data (layers) in a single file. Unlike the ESRI
Shapefile format (e.g. the protected_areas. shp dataset you loaded earlier), a single GeoPackage file can
contain various data (both vector and raster data) in different coordinate reference systems, as well as tables without
spatial information; all these features allow you to share data easily and avoid file duplication.

In order to load a layer from a GeoPackage, you will first need to create the connection to it:

1. Click on the {5 Open Data Source Manager ty,¢p,

2. On the left click on the @ GeoPackage tab.

3. Click on the New button and browse to the training_data.gpkg file in the exercise_data folder
you downloaded before.

4. Select the file and press Open. The file path is now added to the Geopackage connections list, and appears in
the drop-down menu.

You are now ready to add any layer from this GeoPackage to QGIS.

1. Click on the Connect button. In the central part of the window you should now see the list of all the layers
contained in the GeoPackage file.

2. Select the roads layer and click on the Add button.
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Data Source Manager | GeoPackage

W srowser Connections
- g Vector training_data.gpkg@/media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg v
4 Raster New Remove
X1/
et W Table - Type Geometry column Sql
- ~ /media/sf_GitHub/QGIS-Training-Data/exercise_data/training_data.gpkg
4 Delimited Text buildings & MultiPolygon geom
% GeoPackage roads ' LineString  geem
i’:_ SpatiaLite
+ PostgreSQL
* MSSQL
082, pB2
m Virtual Layer
ﬁ WMS/WMTS
L5 wes
e WFS [ )

=
Also list tables with no geometry

.)‘4'- ArcGIS Map Server

ArcGIS Feature
Server

& GeoNode @Help Set Filter «/ Add % Close

Search options

A roads layer is added to the Layers panel with features displayed on the map canvas.
3. Click on Close.

Congratulations! You have loaded the first layer from a GeoPackage.

224 Follow Along: Loading vector data from a SpatiaLite Database with
the Browser

QGIS provides access to many other database formats. Like GeoPackage, the SpatiaLite database format is an
extension of the SQLite library. And adding a layer from a SpatiaLite provider follows the same rules as described
above: Create the connection —> Enable it —> Add the layer(s).

While this is one way to add SpatiaLite data to your map, let’s explore another powerful way to add data: the Browser.
1. Click the ﬂ icon to open the Data Source Manager window.

2. Click on the = Browser tab.

3. In this tab you can see all the storage disks connected to your computer as well as entries for most of the tabs
in the left. These allow quick access to connected databases or folders.

For example, click on the drop-down icon next to the 0 GeoPackage entry.  Youll see the
training-data.gpkg file we previously connected to (and its layers, if expanded).

4. Right-click the ﬁ’ SpatiaLite entry and select New Connection....

5. Navigate to the exercise_data folder, select the landuse . sglite file and click Open.
Notice that a g landuse.sqlite entry has been added under the SpatiaLite one.

6. Expand the g landuse.sqlite entry.

2.2. Lesson: Adding your first layers 17
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7. Double-click the ' landuse layer or select and drag-and-drop it onto the map canvas. A new layer is added
to the Layers panel and its features are displayed on the map canvas.

Data Source Manager | Browser

_:_.- Browser Browser

QESTHO

B Vector

- Favorites
» [¥% Project Home
Raster

L » [a] Home
A% Mesh ey

® ~ @ GeoPackage

o Delimited Text ~ © training_data.gpkg
_ = buildings

if GeoPackage /" roads

~ / Spatialite

i"'; SpatiaLite * = landuse.sqlite

- PostgreSQL @ PostGls
» mssqQL
e MSSQL £ B2
@ WMS/WMTS
DB%" D82 v &8 XYZ Tiles
WA . ¥ OpenStreetMap
Lﬁ_ virtual Layer @ wes
s @ WFS
\ﬁ“_ WMS/WMTS © ows
—:@:—‘_ WCS @ ArcGisMapServer
&7 ArcGisFeatureServer
.y WFS # GeoNode

%74 ArCGIS Map Server

ArcGIS Feature
* Server

» GeoMNode

Tip: Enable the Browser panel in View » Panels » and use it to add your data. It’s a handy shortcut for the Data
Source Manager » Browser tab, with the same functionality.

Note: Remember to save your project frequently! The project file doesn’t contain any of the data itself, but it
remembers which layers you loaded into your map.

2.2.5 222l Try Yourself: Load More Vector Data

Load the following datasets from the exercise_data folder into your map using any of the methods explained
above:

* buildings

* water

Answer
Your map should have seven layers:
* protected_areas

e places
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* rivers

* roads

* landuse

* buildings (taken from training_data.gpkg) and

e water (taken from exercise_data/shapefile).

2.2.6 Follow Along: Reordering the Layers

The layers in your Layers list are drawn on the map in a certain order. The layer at the bottom of the list is drawn
first, and the layer at the top is drawn last. By changing the order that they are shown on the list, you can change the
order they are drawn in.

Note: You can alter this behavior using the Control rendering order checkbox beneath the Layer Order panel. We
will however not discuss this feature yet.

The order in which the layers have been loaded into the map is probably not logical at this stage. It’s possible that the
road layer is completely hidden because other layers are on top of it.

For example, this layer order...

Layers (=]ES)
¢ &%V E-® AL

v| ] water

v [ buildings

v [ landuse

v — roads

v| — rivers

v/ * places

v [[] protected_areas

... would result in roads and places being hidden as they run underneath the polygons of the landuse layer.
To resolve this problem:

1. Click and drag on a layer in the Layers list.

2. Reorder them to look like this:

2.2. Lesson: Adding your first layers 19
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You'll see that the map now makes more sense visually, with roads and buildings appearing above the land use regions.

2.2.7 In Conclusion

Now you’ve added all the layers you need from several different sources and created a basic map!

2.2.8 What’s Next?

Now you're familiar with the basic function of the Open Data Source Manager button, but what about all the others?
How does this interface work? Before we go on, let’s take a look at some basic interaction with the QGIS interface.
This is the topic of the next lesson.

2.3 Lesson: Navigating the Map Canvas

This section will focus on basic QGIS navigation tools used to navigate within the Map Canvas. These tools will allow
you to visually explore the layers at different scales.

The goal for this lesson: Learn how to use Pan and Zoom tools within QGIS and learn about map scale.

2.3.1 Follow Along: Basic Navigation Tools

Before learning how to navigate within the Map Canvas, let’s add some layers that we can explore during this tutorial.

1. Open a new blank project and using the steps learnt in Create a Map, load the previously seen pro-—
tected_areas, roads and buildings layers to the project. The result view should look similar to
the snippet in Fig. 2.2 below (colors do not matter):
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Fig. 2.2: Protected areas, roads and buildings added

Let’s first learn how to use the Pan Tool.

1. In the Map Navigation Toolbar, make sure the @ Pan button is activated.
2. Move the mouse to the center of the Map Canvas area.
3. Left-click and hold, and drag the mouse in any direction to pan the map.

Next, let’s zoom in and take a closer look at the layers we imported.

1. In the Map Navigation Toolbar, click on the 4*+’ Zoom In bystton,
2. Move your mouse to approximately the top left area of where there is the highest density of buildings and roads.
3. Left click and hold.

4. Then drag the mouse, which will create a rectangle, and cover the dense area of buildings and roads (Fig. 2.3).
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Fig. 2.3: Zoom in

5. Release the left click. This will zoom in to include the area that you selected with your rectangle.
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6. To zoom out, select the }9 Zoom Out byytton and perform the same action as you did for zooming in.

As you pan, zoom in, or zoom out, QGIS saves these views in a history. This allows you to backtrack to a previous
view.

1. In the Map Navigation Toolbar, click on ;a Zoom Last hytton to go to your previous view.

2. Click on }a Zoom Next bytton to proceed to move forward in your history.
Sometimes after exploring the data, we need to reset our view to the extent of all the layers. Instead of trying to use
the Zoom Out tool multiple times, QGIS provides us with a button to do that action for us.

1. Click on the ﬂ Zoom Full Extent tyyon,

As you zoomed in and out, notice that the Scale value in the Status Bar changes. The Scale value represents the Map
Scale. In general, the number to the right of : represents how many times smaller the object you are seeing in the
Map Canvas is to the actual object in the real world.
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Coordinate  20.6324,-34.0757 - Scale 1:128472 ~ | & Magnifier 100% +| Rotation |0.0° 5| v/ Render X @

You can also use this field to set the Map Scale manually.
1. In the Status Bar, click on the Scale text field.

2. Type in 50000 and press Enter. This will redraw the features in the Map Canvas to reflect the scale you
typed in.

3. Alternatively, click on the options arrow of the Scale field to see the preset map scales.

£
1:1000000 =
1:500000
1:250000
1:100000
1:50000
1:10000
1:5000
1:2500
1:1000 '~
b Scale|1:50000 v

4. Select 1:5000. This will also update the map scale in the Map Canvas.

Now you know the basics of navigating the Map Canvas. Check out the User Manual on Zooming and Panning to
learn about alternative ways of navigating the Map Canvas.

2.3.2 In Conclusion

Knowing how to navigate the Map Canvas is important, as it allows one to explore and visually inspect the layers.
This could be done for initial data exploration, or to validate output of a spatial analysis.

2.4 Lesson: Symbology

The symbology of a layer is its visual appearance on the map. The basic strength of GIS over other ways of repre-
senting data with spatial aspects is that with GIS, you have a dynamic visual representation of the data you’re working
with.

Therefore, the visual appearance of the map (which depends on the symbology of the individual layers) is very
important. The end user of the maps you produce will need to be able to easily see what the map represents. Equally
as important, you need to be able to explore the data as you’re working with it, and good symbology helps a lot.

In other words, having proper symbology is not a luxury or just nice to have. In fact, it’s essential for you to use a
GIS properly and produce maps and information that people will be able to use.

The goal for this lesson: To be able to create any symbology you want for any vector layer.
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24.1 Follow Along: Changing Colors

To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of the 1anduse layer.
1. Right-click on the 1anduse layer in the layers list.

2. Select the menu item Properties... in the menu that appears.

Note: By default, you can also access a layer’s properties by double-clicking on the layer in the Layers list.

Tip: The d button at the top of the Layers panel will open the Layer Styling panel. You can use this panel
to change some properties of the layer: by default, changes will be applied immediately!

3. In the Layer Properties window, select the @( Symbology tab:

Layer Properties - landuse | Symbology
S [Esinglesymbol -]

@ nformation I T ¢ |

. [ simple fill

3 source

& symbology
€3 Labels
€D Masks Unit | Millimeters ~|
. Opacity 1/1000% |+
a Diagrams -
Color | H
N# 3D View
E Fields
E Attributes Form | . Favorites ~| 8
Joins
F
£} Auxiliary Storage
a - SR
@ Actions ) . . . .
" gradient gray 3 fill hashed black / hashed black\,  hashed black X outline blue outline green outline red
L
, Display plasma
. : r
“ Rendermg . @ - - -
i [
Variables
. outline xpattern pattern dot pattern zelda simple blue fill  simple green fill  simple red fill
a [LEELELE] black
" Dependencies )= |save Symbol...| Advanced - |
Legend » Layer Rendering
&4 qais server .| @relp || style - | /apply || ®cancel | [ /oK ]

4. Click the color select button next to the Color label. A standard color dialog will appear.
5. Choose a gray color and click OK.

6. Click OK again in the Layer Properties window, and you will see the color change being applied to the layer.
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2.4.2 Try Yourself:

Change the color of the water layer to light blue. Try to use the Layer Styling panel instead of the Layer Properties
menu.

Solution

 Verify that the colors are changing as you expect them to change.

« It is enough to select the water layer in the legend and then click on the '& Open the Layer Styling panel o
Change the color to one that fits the water layer.

symbology - QGIS
Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEERRRY UL AHPPRPLAALGREINRS 6 H-0-5EHE I =- 0

LR /VBR&R-BE @5 E ey s g g R
Layers ® Layer Styling ®
o 0l e TE-F » (= water -
N & = Single symbol -
7] ] simple fill
v || water
[
v [[] landuse
& OaflY
unit | Millimeter x| =
OpaCity e—— | 100.0% |+
Color
. Favorites a|-| i

b Layer Rendering

Layers | Browser oo V| Live update | « Apply

2 Type to locate (Ctrl+K) Coordinate| 205265339850 | Scale 1:50008 ~| @ Magnifier 100% 2| Rotation |0.0° +| v/ Render @ Epscia3ze @

If you want to work on only one layer at a time and don’t want the other layers to distract you, you can hide a layer
by clicking in the checkbox next to its name in the layers list. If the box is blank, then the layer is hidden.

24.3 Follow Along: Changing Symbol Structure

This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we want to eliminate the
lines between the different land use areas so as to make the map less visually cluttered.

1. Open the Layer Properties window for the 1anduse layer.
Under the (3/ Symbology tab, you will see the same kind of dialog as before. This time, however, you’re
doing more than just quickly changing the color.
2. In the symbol layers tree, expand the Fill dropdown and select the Simple fill option.
3. Click on the Stroke style dropdown. At the moment, it should be showing a short line and the words Solid Line.
4. Change this to No Line.
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Layer Properties - landuse — Symbology oA X
| Z Single symbol -]
fi Information 3 ~ [ Fill | @ |
[ simple Fill
A2 cour
A& Source —
|Cd) | &)
Qf Symbology
€I Labels
B mMasks Symbol layer type Simple Fill - |
g 30 view Fill color . | €
'. Diagrams Fill style |l solid - &
g reos stroke color I |
E Attributes Form stroke width |0'260000 = |'| |M|II|meter5 M | 1=
: Stroke style | Mo Line - | el
Joins
. Join style |a Bevel hd | L=l
£ ) Auxiliary Storage
x | 0,000000  ——
&} Actions Offset |Mi|limeters - | L=l
y | 0,000000 |: B
- Display
P, Rendering V| Enable symbol layer ], Draw effects
“ Temporal b Layer Rendering
Variables = | B Aide | | Style '| v Ok l |\/ﬁppliquer | | & Annuler |

5. Click OK.

Now the 1anduse layer won't have any lines between areas.

24.4 Try Yourself:

* Change the water layer’s symbology again so that it has a darker blue outline.

* Change the rivers layer’s symbology to a sensible representation of waterways.

Remember: you can use the d Open the Layer Styling panel by;tton and see all the changes instantly. That panel also allows
you to undo individual changes while symbolizing a layer.

Answer

Your map should now look like this:
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symbology - QGIS 0

Project Edit View Layer Settings Plugins Vector Raster Database Web Help
0 B (e, HPPLARRINLS &6 N-N-GEHE I - [T
REV.AR J/BVER-ZT BB =4 HEB3%T R 2 « K

@® Layer Styling =[]
® /" rivers -
& = Single symbol -
v b 5 — Simple line
areas D
8 ' K
= B
Q & O allw
{
= e unit  Millimeter x|~
N Opacity _1/100.0 % =
’ color | NN
Wwidth | 0.36000 ERES
<. Favorites a |- a
» Layer Rendering
Layers | Browser b e V| Live update | « Apply
Q Type to locate (Ctrl+K) Coordinate  20.3963-34.0335 | 9§  Scale | 1:51337 ~ | @ Maagnifier| 100% 2| Rotation |0.0° || Render ¢ EPSG:4326 @

If you are a Beginner-level user, you may stop here.
 Use the method above to change the colors and styles for all the remaining layers.
» Try using natural colors for the objects. For example, a road should not be red or blue, but can be gray or black.

* Also feel free to experiment with different Fill style and Stroke style settings for the polygons.

symbology - QGIS
Project Edit View Layer Settings Plugins WVector Raster Database Web Help

NEEBRREY NE,sNPPAAGBEIS 66 -0 - B8 e -
BV A y/BRER-ZTd<8 B o g e E o on = @A x

Layers ® Layer Styling ®
|0 e T & -8 » - 7 buildings -
Vi 8 places = Single symbol -
v/ — roads nd
7 — rteere __F
v! [l buildings W simple fill
v| [ | water | " .
v || protected_areas , ML ¢ i "l
v landuse
’, 7 & ol[a|[¥
<4 =
i unit  Millimeter |~
Opacity _1/100.0 % -
Color I
. Favorites a|-| &
P Layer Rendering
Layers | Browser / LIS V| Live update | « Apply
Q Type to locate (Ctrl+K) Coordinate| 20.5355-33.9815 |5 Scale 1:53664 ~ | @ Magnifier 100% ~| Rotation |0.0° +| v Render @ Epsc:4326 @
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245 Follow Along: Scale-Based Visibility

Sometimes you will find that a layer is not suitable for a given scale. For example, a dataset of all the continents may
have low detail, and not be very accurate at street level. When that happens, you want to be able to hide the dataset
at inappropriate scales.

In our case, we may decide to hide the buildings from view at small scales. This map, for example...

symbology - QGIS %

Project Edit View Layer Settings Plugins Vector Raster Database Web Help

DEBREERY UPLPL o HNPPLALAGREIRS Q6 K-N-5EHEE & [0
REV.A® #/BRR-B T >0 B “4HYUERSL R 2 « X

Layers @&
« @l T &k

vl = places

V| — roads

V| — rivers

v [7] bulldings

v/ [ | water

I protected_areas

v landuse

|
/
a

Layers = Browser

Q Type to locate (Ctrl+K) sordinal| 20.7122-33.9589 | zal|1:150104 |~ | & agnifi 100% 2| otatic |0.0° | ¥ Render % EPSGid3z6 @

... is not very useful. The buildings are hard to distinguish at that scale.
To enable scale-based rendering:

1. Open the Layer Properties dialog for the buildings layer.

2. Activate the f Rendering tab.
3. Enable scale-based rendering by clicking on the checkbox labeled Scale dependent visibility:
4. Change the Minimum value to 1:10000.
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Layer Properties - landuse — Rendering

w v Scale Dependent Visibility

esifEn Minimum (exclusive) Maximum (inclusive)
42 [1:10000 - | &)+ B o - | 8|~
Source
Symbology v/ Simplify Geometry
- Mote: Feature simplification may speed up rendering but can result in rendering inconsistencies
abels
Simplification threshold (higher values result in more simplification) 1,00 2| pixels
T EL - ) -
Simplification algorithm Distance -~

3D View

Simplify on provider side if possible (Not suppc

Diagrams Maximum scale at which the layer should be simplified (1:1 always simplifies) | 1:1 -

Fields b Fixed Reference Scale

Attributes Form P Selections

£
¥
 abc)
(abc]
N
-

]
-5}

Force layer to render as a raster (may result in smaller export file sizes)
Joins
Refresh layer at interval

Auxiliary Storage
Actions

Display

Rendering ) | |

Interval (seconds)

L]« R o

Temporal
Refresh layer on notification Only if m

VELEL

-

Elevation

i Aide Style - v Ok « Appliquer | | & Annuler

5. Click OK.

Test the effects of this by zooming in and out in your map, noting when the buildings layer disappears and
reappears.

Note: You can use your mouse wheel to zoom in increments. Alternatively, use the zoom tools to zoom to a window:

ye

246 Follow Along: Adding Symbol Layers

Now that you know how to change simple symbology for layers, the next step is to create more complex symbology.
QGIS allows you to do this using symbol layers.

1. Go back to the 1anduse layer’s symbol properties panel (by clicking Simple fill in the symbol layers tree).

In this example, the current symbol has no outline (i.e., it uses the No Line border style).
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Layer ties - landuse — Symb 'y oo XK
| = Single Symbol -]
fi Information 3 ~ [ Fill |@|
[ simple Fill
;.':‘- Source |ﬁ| |?|
' 2
d Symbology
€I Labels
BB Masks symbol layer type| simple Fill - |
g 30 view Fill color . | €
'. Diagrams Fill style |- Solid = | L=
g reos stroke color O | <.
E Attributes Form stroke width |0,260000 = |'| |M|II|meter5 M | 1=
: Stroke style | Mo Line - | el
Joins
. Join style |a Bevel hd | L=l
£ ) Auxiliary Storage
x | 0,000000  ——
&} Actions Offset |Mi|limeters - | L=l
y | 0,000000 |: B
. Display
& ’ Rendering V| Enable symbol layer ], Draw effects
ﬁ Temporal b Layer Rendering
Variables = | B Aide | | Style '| v Ok l | « Appliquer | | & Annuler |

2. Select the Fill level in the tree and click the Ifl-l-ll:| Add symbol layer 1ytton, The dialog will change to look something
like this, with a new symbol layer added:
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Layer Properties - landuse | Symbology >

= Single symbol =
"’;’ Information ~ H Fill
Simple Fill =l
33 source . [X simple Fill .
' =E
& symbology
€= Labels
symbol layer type Simple Fill -
D Masks Y ver typ s
. i O
S Fill color [=h
Fill style I solid -
WF 3D View 2 &
stroke color | [ - <.
E Fields
Stroke width | 0,260000 @ |7 |Millimeters K =N
E Attributes Form —
Stroke style | ——Solid Line - | €
Joins Join style 1 Bevel K=
ﬁ Auxiliary Storage x | 0,000000 -
Offset Millimeters -
U_@ Actions y | 0,000000 =
® oisplay v| Enable symbol layer 4=, Draw effects
Qj,/ Rendering
» Layer Rendering
e dblee @Help Style -~ « Apply || % cancel «/ OK

-

It may appear somewhat different in color, for example, but you’re going to change that anyway.

Now there’s a second symbol layer. Being a solid color, it will of course completely hide the previous kind of symbol.
Plus, it has a Solid Line border style, which we don’t want. Clearly this symbol has to be changed.

Note: It’s important not to get confused between a map layer and a symbol layer. A map layer is a vector (or raster)
that has been loaded into the map. A symbol layer is part of the symbol used to represent a map layer. This course
will usually refer to a map layer as just a layer, but a symbol layer will always be called a symbol layer, to prevent
confusion.

With the new Simple Fill symbol layer selected:
1. Set the border style to No Line, as before.

2. Change the fill style to something other than Solid or No brush. For example:
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[T rties - landuse — Symbology v oA X
&[S singlesymbol =
(3 information ] - & Fin ||
I simple Fill =[v
S mple i (=) (V]
AW Source I simple Fill =
| (&)
d Symbology
€3 Labels
B Masks Symbol layer typel Simple Fill = |
N 30 View Fill color S - €
'I Diagrams Fill style H:Hi Cross - | S
g oo stroke color |
E ., — Stroke width 0,260000 a |,,| | Millimeters = | L =8
Stroke style | Mo Line - | L el
Joins
. Join style |“ Bevel = | el
£ ] Auxiliary Storage
x | 0,000000 [ —
B} Actions Offset |Mi|limeter5 - | el
y | 0,000000 s
- Display
V| Enable symbol layer =], Draw effects
4 Rendering
ﬁ Temporal b Layer Rendering
) = | B Aide | | Style '| v Ok l |\/ﬁppliquer | | © Annuler |

3. Click OK.

Now you can see your results and tweak them as needed. You can even add multiple extra symbol layers and create
a kind of texture for your layer that way.

O |- |
4 simple Fill
IF simple Fill
] simple Fill

It’s fun! But it probably has too many colors to use in a real map...
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24.7 Try Yourself:

Remembering to zoom in if necessary, create a simple, but not distracting texture for the buildings layer using
the methods above.

Answer

Customize your buildings layer as you like, but remember that it has to be easy to tell different layers apart on
the map.

Here’s an example:

symbology - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Help

NEBERRY O o2 8PP, &6 -N-N-FEET -
BV, A W JBRR-Z O <8 B i = - T ® 2 . »

Layers 3 &
v 3w TE B0

v/ * places

v — roads

v — rivers

v [ buildings

v| [ ] water

v/ [ ] protected_areas
v landuse

/ 3
Layers Browser & \\
Q Type to locate (Ctrl+K) 1| 20.45040-34.01345 9 | 1:5000 ~| @ r|[100% >l 1 |00° +| v/ Render % EpsG432e @

24.8 Follow Along: Ordering Symbol Levels

When symbol layers are rendered, they are also rendered in a sequence, similar to the way the different map layers
are rendered. This means that in some cases, having many symbol layers in one symbol can cause unexpected results.

1. Give the roads layer an extra symbol layer (using the method for adding symbol layers demonstrated above).
2. Give the base line a Stroke width of 1.5 and a black color.
3. Give the new, uppermost layer a thickness of 0. 8 and a white color.

You'll notice that this happens:
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Well, roads have now a street like symbology, but you see that lines are overlapping each others at each cross. That’s
not what we want at all!

To prevent this from happening, you can sort the symbol levels and thereby control the order in which the different
symbol layers are rendered.

To change the order of the symbol layers:
1. Select the topmost Line layer in the symbol layers tree.

2. Click Advanced w» Symbol levels... in the bottom right-hand corner of the window.

Layer Properties - training_data — roads — Symbology

= Single Symbol

G’ Information * = Line s
Simple Line
q\:\? Source = Simple Line
&¢ symbology
€ Labels
€D Masks color | (N (-
.,“ 3D View Opacity 100,0 % =y =l
Diagrams Width 1,50000 = | | Millimeters - @'
E Fields O, Favorites a|~| 8t
Attributes Form Default
Joins
........................ (—
ﬁ Auxiliary Storage
{.@ Actions dash black dash blue dash green dash red effect emboss —

@ oisplay H]l=

"/ Rendering

p Layer Rendering
0 Temporal —| BlAide Style ~
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This will open a dialog like this:

symbol Levels S

Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

@Help oK

-

* Cancel &

=

3. Check oA Enable symbol levels. You can then set the layer order of each symbol by entering the corresponding
level number. 0 is the bottom layer.

In our case, we just want to activate the option, like this:

symbol Levels 0

v| Enable symbol levels

Define the order in which the symbol layers are rendered. The numbers
in the cells define in which rendering pass the layer will be drawn.

Layer O Layer 1

—_ = ) 1

@Help % Cancel

7
-
(o
-~

This will render the white line above the thick black line borders:

4. Click OK twice to return to the map.

The map will now look like this:
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N

When you’re done, remember to save the symbol itself so as not to lose your work if you change the symbol again
in the future. You can save your current symbol style by clicking the Save Style... button at the bottom of the Layer
Properties dialog. We will be using the QGIS QML Style File format.

Save your style in the solution/styles/better_roads.qml folder. You can load a previously saved style
at any time by clicking the Load Style... button. Before you change a style, keep in mind that any unsaved style you
are replacing will be lost.

24.9 Try Yourself:

Change the appearance of the roads layer again.

Make the roads narrow and yellow, with a thin, pale gray outline and a thin black line in the middle. Remember that
you may need to change the layer rendering order via the Advanced » Symbol levels... dialog.

Answer

To make the required symbol, you need three symbol layers:
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Layer Properties - roads (triple_levels) | Symbology

| = single symbol 5
@ information g e |

— Simple line
A% source simple line

= Simple line

Q’ Symbology

€3 Labels —
& AN
'I Diagrams
~ Unit  Millimeter -
W 3D View Opacity [1000% |7
E SourceFields eyl ]
Attributes
Form width | 2.10000 s &
Joins
= ) . .r
L Auxiliary | @ Favorites a |- e
&1 storage =~
@ Actions
I | - ---===  =s=s===:  ======: ======= e —
. Display
‘ Rendering dash black dash blue dash green dash red effect emboss effect neon
Variables |:| IE |save Ssymbol | | Advanced ~|
ah Metadata
P Layer Rendering
™ Dependencies _| @Help | style -| | «/Apply || %cancel |’ «/ OK ]

The lowest symbol layer is a broad, solid gray line. On top of it there is a slightly thinner solid yellow line and finally
another thinner solid black line.

If your symbol layers resemble the above but you're not getting the result you want:

1. Check that your symbol levels look something like this:

Symbol Levels

v Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1 Layer
= =0 1 —2
[] >
| @Help | | % cancel |[ « OK ]

2. Now your map should look like this:
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2.4.10 Try Yourself:

Symbol levels also work for classified layers (i.e., layers having multiple symbols). Since we haven’t covered classi-
fication yet, you will work with some rudimentary pre-classified data.

1. Create a new project and add only the roads dataset.

2. Apply the style file advanced_levels_demo.qgml provided in exercise_data/styles to the
layer. This can be done through the Style » Load Style... combobox at the bottom of the Layer Properties
dialog.

3. Zoom in to the Swellendam area.

4. Using symbol layers, ensure that the outlines of layers flow into one another as per the image below:
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Answer
1. Adjust your symbol levels to these values:

Symbol Levels B

¥| Enable symbol levels

Define the order in which the symbol layers are
rendered. The numbers in the cells define in which
rendering pass the layer will be drawn.

Layer 0 Layer 1
T Trunk | 3
—|Tertiary LI 2
= Unclassified == 0 1

@Help % cancel

1. Experiment with different values to get different results.

2. Open your original map again before continuing with the next exercise.
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2.4.11 Follow Along: Symbol layer types

In addition to setting fill colors and using predefined patterns, you can use different symbol layer types entirely. The
only type we’ve been using up to now was the Simple Fill type. The more advanced symbol layer types allow you to
customize your symbols even further.

Each type of vector (point, line and polygon) has its own set of symbol layer types. First we will look at the types
available for points.

Point Symbol Layer Types

1. Uncheck all the layers except for places.

2. Change the symbol properties for the places layer:

Layer Properties - places | Symbology
| = single symbol ]

'rf Information

@ Simple marker

;.'@ Source

Q’ Symbology
€2 Labels
€D Masks Unit | Millimeters -
: Opacity 1100,0% |+
, Diagrams =
Color | H
e . -
g 3D View Size 2,00000 BKE=S
i retos Rotation | 0,00 ° | €
E Attributes Form | O Favorites @ |~ | 8
Joins
ﬁ Augxiliary Storage ® O @ O O *
@ Actions )
dot black dot white dot blue dot green dok red effect drop
. shadow
- Display
& Rendering 3 @ ®

Variables
shield disability topo hospital  topo pop capital

E Metadata

|save Symbol... | |Advanced - |

M Dependencies |_| =

» Layer Rendering
[ @relp |[ syie - _Jaoply || ®cancel |[ ok

3. You can access the various symbol layer types by selecting the Simple marker layer in the symbol layers tree,
then click the Symbol layer type dropdown:
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Layer Properties - places | Symbology

Q = Single symbol -

Ellipse marker

fi Information

Filled marker

15
W Source Font marker

(0t}

& symbology Geometry generator

Mask

€3 Labels .
Raster image marker —

O Masks symbol layer type[STiTE El TN

- : . SVG marker
. [MELEINE Size .
Vector field marker
Np 3D View Fill color N | S
E Fields stroke color | (I - <.
E Attributes Form Stroke style | —— Solid Line ~| &
. Stroke width | Hairline || Millimeters ~| &
Joins
. Join style 5 Bevel ~| S
ﬂ Augxiliary Storage
Rotation 0,00° = EL
o actions 0,000000 =
) X0, -
® Display Offset Millimeters ~| &
y | 0,000000 =
rd .
4  Rendering VCenter MRS
Anchor point
VELELIES . HCenter -~ &
[ Metadata
& OCO0AAKXT@++X 1| > D
ﬁ Dependencies £ a O O |_| I\ /] “ a -

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Investigate the various options available to you, and choose a symbol with styling you think is appropriate.

5. If in doubt, use a round Simple marker with a white border and pale green fill, with a Size of 3. 00 and a Stroke
width of 0. 5.

Line Symbol Layer Types

To see the various options available for line data:

1. Change the Symbol layer type for the roads layer’s topmost symbol layer to Marker line:
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"i Information

-?& Source

Q’ Symbology

€= Labels

B Masks

: Diagrams

N7 3D View

E Fields

E Attributes Form

Joins

ﬁ Augxiliary Storage

@ Actions
- Display

&  Rendering

Variables
E Metadata

ﬁ Dependencies

| = single symbol

[ @rep | syle -

Layer Properties - roads | Symbology

v — Line

Arrow
Geometry generator
Hashed line

Marker line &
symbol layer type| Simple line

Color . ] E| L=
Stroke width | 0,260000 @ ||| Milimeters  ~| &,
Offset 10,000000 2| Millimeters  ~| &
stroke style | ——Solid Line K=
Join style | B Bevel - &
Cap style | B square - e
Use custom dash pattern
| Millimeters - g

v| Enable symbol layer 4=, Draw effects

P Layer Rendering

 /Apply || %cancel || JoK |

2. Select the Simple marker layer in the symbol layers tree. Change the symbol properties to match this dialog:

2.4. Lesson: Symbology

43



QGIS Training Manual

Layer Properties - roads | Symbology
| = single symbol

"i Information ~ -+ Line |E|
* . - Marker line

;{s} Source v - Marker

Q/ Symbology

""""" jla

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 0,500000 |$| | Millimeters ~| &
.." 3D View Fill color | E| (=8
B s stroke color | MM | <,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
& Rendering \VCenter - &
Variables Anchor point 'HCenter aK=E
| Metadat:
AT D000AAK T @++X | > b
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Select the Marker line layer and change the interval to 1.00:
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Layer Properties - roads | Symbology

Q = Single symbol -

%) Information ~ . Line e

3

"W Source ~ + Marker =
- simple marker L2

Q’ Symbology

€3 Labels

B Masks symbol layer type| Marker line -

: Diagrams Marker placement =,

.‘.’, 3D View (s with interval 1,000000 < | | Millimeters ~ &

E Fields ' on every vertex

() on last vertex only

E Attributes Form ) )
! on first vertex only

Joins (! on central poink
s’i Augxiliary Storage ) on central point of segments

() on every curve point

{;'.-® Actions
- Display

Q." Rendering

Offset along line 0,000000 Millimeters ~| &

v| Rotate marker to Follow line direction

Average angle over | 4,000000 < | Millimeters ~| &
Variables Line offset 0,000000 2 |Millimeters  ~ | &
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering

@Help Style - «/ Apply || % Cancel

4. Ensure that the symbol levels are correct (via the Advanced w Symbol levels dialog we used earlier) before
applying the style.

Once you have applied the style, take a look at its results on the map. As you can see, these symbols change direction
along with the road but don’t always bend along with it. This is useful for some purposes, but not for others. If you
prefer, you can change the symbol layer in question back to the way it was before.

Polygon Symbol Layer Types

To see the various options available for polygon data:
1. Change the Symbol layer type for the water layer, as before for the other layers.
2. Investigate what the different options on the list can do.
3. Choose one of them that you find suitable.

4. If in doubt, use the Point pattern fill with the following options:
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information - Fill |E|
~ °  Point pattern fill
v © Marker

° Q]3]

- |

-?& Source

Q’ Symbology

€3 Labels
EED Masks symbol layer type Simple marker - 1=
: Diagrams Size 2,000000 |$||Millimeter5 ~| &
.r' 3D View Fill color | E| (=8
B s stroke color | (N | =,
E Attributes Form Stroke style | ——Solid Line KEE
Soirs Stroke width | Hairline |‘| | Millimeters MKEN
. Join style | B Bevel - &
5" Augxiliary Storage
Rotation | 0,00° | &
& actions 10,000000 [ P
- x y -
- Offset | Millimeters - &
O oisplay y |0,000000 B
4" Rendering \VCenter K=
Variables Anchor point 'HCenter aK=E
 srctad
B mecadoro OCO00CAANXTO@F+F X | DD
"™ Dependencies Dd aoif hA M a -
P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |
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Layer Properties - water | Symbology
& [Ssinglesymbol

%) Information ~ . . Fill | |

a cooo Point pattern Fill
"W Source o000 v © Marker — =
o000 © simple marker |E| |Q|
Q’ Symbology o000
€3 Labels
B Masks symbol layer type Point pattern fill - |
: Diagrams Distance
Horizontal |4,000000 <| | Millimeters K =R
N7 3D View [ | <] |
Vertical | 4,000000 2| Millimeters  ~| &
E Fields .
Displacement
B8 Attributes Form Horizontal | 0,000000 4| Mmillimeters  ~| &
Joins Vertical | 0,000000 4| Mmillimeters  ~ | &
L Offset
5" Augxiliary Storage
Horizontal | 0,000000 2| Millimeters  ~| &
@ Actions - —
Vertical | 0,000000 2| Millimeters  ~| &
- Display
g. Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

5. Add a new symbol layer with a normal Simple fill.
6. Make it the same light blue with a darker blue border.

7. Move it underneath the point pattern symbol layer with the Move down button:
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Layer Properties - water | Symbology X

Q = Single symbol -

fi Information ~ | Fill o
2 simple Fill = @

"% Source » . . Point pattern Fill Olla
& symbology -
€3 Labels
B Masks symbol layer type Simple Fill -
-

, Diagrams Fllcolor | M - (=,
N7 3D View Fill style I solid -la
E Fields stroke color | (I - =
E P — Stroke width | 0,260000 = | Millimeters ~| &

. Stroke style |—— Solid Line K=k
Joins
. Join style 5 Bevel ~| S
E_" Augxiliary Storage -
X | 0,000000 -
@ Actions Offset Millimeters -
. y | 0,000000 =
- Display
/ .
4 Rendering
Variables

E Metadata

ﬁ Dependencies v| Enable symbol layer <=, Draw effects
P Layer Rendering
@Help Style - «/ Apply || % Cancel o OK

As a result, you have a textured symbol for the water layer, with the added benefit that you can change the size, shape
and distance of the individual dots that make up the texture.

2412 Try Yourself:

Apply a green transparent fill color to the protected_areas layer, and change the outline to look like this:
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Answer

Here are examples of the symbol structure:

Layer Properties - protected_areas | Symbology
| = single symbol -

"rf Information ~ . Fill

Marker line Nhkddk
;-'o_';_\ Source ~ 4 Marker : :
+ Simple marker ) >
w' symbology simple Fill ayvvvy
€2 Labels — — — — —
1®||=|8laallY]
. Diagrams
symbol layer type| Outline: Marker line v| =
u# 3D View
Marker placement <,
E Source Fields ® with | | I la
®) with interval |3.000000 = Millimeter -
Attributes
Form ) on every vertex
Joins ) on last vertex only
&% Auxiliary ) on first vertex only
L Storage )
: _! on central point
& Actions ]
- ! on every curve point
Display y | PP
Offset along line | 0.000000 || Millimeter -~ &
& Rendering ¥| Rotate marker
Variables Line offset |0.000000 /| Millimeter K=
!h Metadata T I
P Layer Rendering
™ Dependencies _| @Help | stle -| | «/Apply || ®cancel |’ «/ OK ]
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Layer Properties - protected_areas | Symbology

| 2 single symbol -

- LI
(3" information ¥ .7 Fill

¥ i 4 Marker line ey

;{0} Source * 4+ Marker - -

1 £
& symbology simple Fill avrvyy
€3 Labels — ——

1E|[=|8]|3]| a]l¥
'I Diagrams

Symbol layer type| Simple marker v| =
W 3D View

Size |2.200000 2| | Millimeter -~ e
E Source Fields .

: i ]
Attributes AlLe | l;| &
— Stroke color | H (=R
Joins ~

o stroke style | ——Solid Line aK=E
=~ Auxiliary
& B storage Stroke width | 0.200000 @ ||| Millimeter K =N
@ Actions Join style | B Bevel - a
. Display Rotation |0.00° |:| <
o o x | 0.000000 s
& Rendering Offset | | Millimeter aK=E
Variables y 0.000000 |'|
| vcenter K =

ah Metadata

P Layer Rendering

™ Dependencies _| @Help | style -| | «/Apply || %cancel |’ «/ OK ]

24.13 Follow Along: Geometry generator symbology

You can use the Geometry generator symbology with all layer types (points, lines and polygons). The resulting symbol

depends directly on the layer type.

Very briefly, the Geometry generator symbology allows you to run some spatial operations within the symbology

itself. For example you can run a real centroid spatial operation on a polygon layer without creating a point layer.
Moreover, you have all the styling options to change the appearance of the resulting symbol.
Let’s give it a try!

1. Select the water layer.

2. Click on Simple fill and change the Symbol layer type to Geometry generator.
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(] Centroid Fill
| Z single symbol

G‘ Information

Geometry ge'?eratcr
Gradient fill

Line pattern Fill
Point pattern Fill
Random marker Fill 3

-?& Source

Q’ Symbology

Raster image Fill
€3 Labels SVG Fill
Shapeburst Fill

B Masks symbol layer typ
simple Fill
-
, Diagrams Fill color | Outline: Arrow
.r' 3D View Fill style | Outline: Hashed line
- | Outline: Marker line
i Stroke color
E Fields Outline: simple line
E Attributes Form Stroke width | 0,260000 @ [7[|Millimeters ~ T &
. Stroke style | ——Solid Line -~ &
Joins
. Joinstyle | T Bevel -~ &
E" Augxiliary Storage -
x | 0,000000 - |—
1B Actions Offset - | Millimeters ~|
y | 0,000000 2] R
- Display
&  Rendering
Variables
E Metadata
v| Enable symbol layer 4=, Draw effects

E Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

3. Before to start writing the spatial query we have to choose the Geometry Type in output. In this example we
are going to create centroids for each feature, so change the Geometry Type to Point / Multipoint.

4. Now let’s write the query in the query panel:

[centroid($geometry) ]
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Layer Properties - water | Symbology
& [Ssinglesymbol

"i Information ~ @ Fill |E|

an
W Source ~ @ Marker e
® simple marker |E| |ﬂ|

Q’ Symbology
€3 Labels
B Masks Symbol layer type| Geometry generator v|
: Diagrams Geometry type | " Point / MultiPaint - |
ﬁ 3D View centroid{$geometry) |E|
E Fields
E Attributes Form

Joins
ﬁ Augxiliary Storage
@ Actions
- Display
&  Rendering

Variables
E Metadata 4 L

v| Enable symbol layer 4=, Draw effects

ﬁ Dependencies

P Layer Rendering
.| @Help || style - JApply || Xcancel || JoK |

5. When you click on OK you will see that the water layer is rendered as a point layer! We have just run a
spatial operation within the layer symbology itself, isn’t that amazing?
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*chapter_3 - QGIS [tm]
Project Edit View Layer Settings Plugins Vector Raster Database Web Progessing Help
*[® e » B D .

BRRR O+FERSBPD A

Layers %

Coordinate| 20.4963.-33.9835 |® Scale|1:34265 |~ @ Magnifier| 100% | Rotation [0.0° :| v Render @ EPSG4326 @

With the Geometry generator symbology you can really go over the edge of normal symbology.

22 Try Yourself:
Geometry generator are just another symbol level. Try to add another Simple fill underneath the Geometry generator

one.

Change also the appearance of the Simple marker of the Geometry generator symbology.

The final result should look like this:
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Answer

1. Click on the "--II:I-II:I button to add another Symbol level.

2. Move the new symbol at the bottom of the list clicking the v button.
3. Choose a good color to fill the water polygons.
4. Click on Marker of the Geometry generator symbology and change the circle with another shape as your wish.

5. Try experimenting other options to get more useful results.

24.14 Follow Along: Creating a Custom SVG Fill

Note: To do this exercise, you will need to have the free vector editing software Inkscape installed.

1. Start the Inkscape program. You will see the following interface:
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You should find this familiar if you have used other vector image editing programs, like Corel.

First, we’ll change the canvas to a size appropriate for a small texture.

Change the Units to px.

NS A »N

Select the Circle tool:

Close the dialog when you are done.

Change the Width and Height to 100.

Click on the menu item File » Document Properties. This will give you the Document Properties dialog.

Click on the menu item View » Zoom » Page to see the page you are working with.
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8. Click and drag on the page to draw an ellipse. To make the ellipse turn into a circle, hold the Ct r1 button
while you're drawing it.

9. Right-click on the circle you just created and open its Fill and Stroke options. You can modify its rendering,
such as:

1. Change the Fill color to a somehow pale grey-blue,
2. Assign to the border a darker color in Stroke paint tab,

3. And reduce the border thickness under Stroke style tab.
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10. Draw a line using the Pencil tool:

1. Click once to start the line. Hold Ctr1 to make it snap to increments of 15 degrees.

2. Move the pointer horizontally and place a point with a simple click.

3. Click and snap to the vertex of the line and trace a vertical line, ended by a simple click.
4. Now join the two end vertices.
5

. Change the color and width of the triangle symbol to match the circle’s stroke and move it around as
necessary, so that you end up with a symbol like this one:
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11. If the symbol you get satisfies you, then save it as landuse_symbol under the directory that the course is

in, under exercise_data/symbols, as SVG file.
In QGIS:

1. Open the Layer Properties for the 1anduse layer.

2. Inthe (}{ Symbology tab, change the symbol structure by changing the Symbol Layer Type to SVG Fill shown

below.

3. Click the ... button and then Select File... to select your SVG image.

It’s added to the symbol tree and you can now customize its different characteristics (colors, angle, effects,

units. ..).
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Layer Properties - landuse | Symbology

| = single symbol

%) Information ~ [ Fill | |
— 4 SVG fill
-?& Source = :J:i v — Line o
7\ r‘ — simple line |E| |Q|
Q’ Symbology E —
€3 Labels
B Masks symbol layer type SVG fill -
: Diagrams Texture width | 10,000000 |:| | Millimeters - &
.r' 3D View Fill color (=8
E Fields Stroke color =8
BB Attributes Form Stroke width | || Millimeters  ~| &
: Rotation 0,00° i &
Joins
SVG Groups SVG symbols
E" Auxiliary Storage ~ [ App Symbols - - . . 252 =
& _ [ accommodation - ..
g Actions ] amenity oy e
: [ arrows i S|e &y x
- Display L

[J backgrounds
[ components

&  Rendering

[ crosses o :
Variables [] emergency |0 ' _ '||
[ entertainment we llwe I
{ Metadata [ food h &
a [ gpsicons X : S Y o | ﬂ%
ﬁ Dependencies [ health
[J landmark = A\ O ‘#’ ’(:}‘ [E— m A =
"~ Legend A
s *nts/GIS/QGIS/TrainingManual/exercise_data/symbols/landuse_symbol.svg & ||_|t| =i
& qais server
v| Enable symbol layer <, Draw effects

ﬂ Digitizing

» Layer Rendering
| @Help || style -  Japply | %cancel |[ ok |

Once you validate the dialog, features in 1anduse layer should now be covered by a set of symbols, showing a
texture like the one on the following map. If textures are not visible, you may need to zoom in the map canvas or set
in the layer properties a bigger Texture width.
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2.4.15 Follow Along: Masking

Masking feature allows you to mask some symbol layer using another symbol layer or label.
In the following exercise, we want to configure rendering so that polygon labels will mask the black part of lines layer.
1. Load the selective_masking.qggs from dataset in directory exercise_data/masking.
2. Open the Layer Properties window for the polys layer.
Under the ‘2kz| Labels tab, you will see that ‘akz| Single Labels have already been defined.

3. From the Labels tab, select the ¢ Mask (and not Masks in general category list)

4. Enable label mask by checking the ) Enable mask option

A message tells you that the now defined label mask shape can be later selected as a mask source to mask other
symbol layers. Let’s do that.

5. Click OK

6. Open the Layer Properties window for the 1 ines layer.

7. Go to the ™ Masks tab
8. Click on the black line part of lines checkbox from masked symbol layers

A message warns you that you have to select both masking and masked symbol layers to be able to save masking
configuration. Again, let’s do that.

9. Click on polys Label mask checkbox

The message disappears, you can now safely save your configuration.
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Q Layer Properties - lines — Masks oA K

Q, Masked symbol layers

Information v

[ Source

& symbology

Labels

[abe) Masks

a /i
3D View Mask sources

~ polys

Diagrams
v Label mask

Fields
Attributes Form
Joins
ﬁ Auxiliary Storage
@ Actions

8 Help Style = v OK + Apply @® Cancel

10. Click OK

You can see now that labels are masking the black part of lines, leaving only the yellow part.
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2.4.16 Follow Along: Masking using points symbols

We want now to mask the black part of lines using only black planes that represent the points layer (i.e. B52 and
Jet points categories). For the sake of visibility, you can switch off polys layer visibility.

1. Open the Layer Properties window for the point s layer.

==
Under the (\f Symbology tab, you will see that a — Categorized renderer has been defined with 3 different
symbols depending on the Class field value.

2. Double click on B52 plane icon, within the Symbol column

Q Symbol Selector v oA X

__ marker . f[U

4+ SVG Marker

color (N -

Opacity 100.0 % i =l

Size 11.00000 < | Millimeters K=l

Rotation | 0.00 ° = =

L. Favorites ~| &

Default .
dot black dot white dot blue dot green dot red

Save Symbol... | | Advanced -

B Help " OK & Cancel

3. Click the Ell'l}:l Add symbol layer byytton and select the Ma sk Symbol layer type

A new hierarchy Ma sk (symbol layer) > Marker (symbol) > Simple Marker (symbol layer) appear below
the root symbol Marker.
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~ fl Marker &
- Mask =|[w
- @& Marker —
|| &

® Simple Marker
al 5vG Marker

Now, let’s define a mask that is identical to our plane marker but a little bit bigger.
4. Select the newly created Simple Marker symbol layer and change its Symbol layer type to SVG marker

5. Set the SVG file path to be the same as the already existing SVG marker, and the size to be bigger (24 mil-
limeters is a pretty good choice for this use case).

Mask color doesn’t matter here, only the shape is used in masking. Symbol layer order is also irrelevant in that
situation.

You should get something like that:

@ Symbol Selector VoA X
~ 4+ Marker |
<+ SVG Marker
- Mask —
~ 4 Marker (=L
SVG Marker
Symbol layer type| SWG Marker - =
Width |18.000000 | E
-
Size Height | 18.000000 A E
Unit Millimeters -
Fill color -

4

@ @ @@@@

Stroke color

Stroke width | Mo stroke = | Millimeters -
Rotation 0.00°®
% | 0.000000 =
Offset Millimeters -
y | 0.000000 -
vCenter -

Anchor point

4

HCenter

w SVG hrawear

H Help + OK | S Cancel

6. Repeat the same operations on Jet symbol.

7. Click OK
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8. Open the Layer Properties window for the 1ines layer.

9. Go to the ** Masks tab.

The black line part of lines checkbox from masked symbol layers is already checked from our previous con-
figuration.

10. Uncheck the Label mask polys checkbox and check both B52 and Jet Mask symbol layer
11. Click OK

You now see that black planes are masking the black part of lines, with only the yellow part visible.

-

A

=3

2.4.17 In Conclusion

Changing the symbology for the different layers has transformed a collection of vector files into a legible map. Not
only can you see what’s happening, it’s even nice to look at!

2.4.18 Further Reading

Examples of Beautiful Maps
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2.4.19 What’s Next?

Changing symbols for whole layers is useful, but the information contained within each layer is not yet available to
someone reading these maps. What are the streets called? Which administrative regions do certain areas belong to?
What are the relative surface areas of the farms? All of this information is still hidden. The next lesson will explain
how to represent this data on your map.

Note: Did you remember to save your map recently?
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CHAPTER
THREE

MODULE: CLASSIFYING VECTOR DATA

Classifying vector data allows you to assign different symbols to features (different objects in the same layer), de-
pending on their attributes. This allows someone who uses the map to easily see the attributes of various features.

3.1 Lesson: Vector Attribute Data

Vector data is arguably the most common kind of data in the daily use of GIS. The vector model represents the location
and shape of geographic features using points, lines and polygons (and for 3D data also surfaces and volumes), while
their other properties are included as attributes (often presented as a table in QGIS).

Up to now, none of the changes we have made to the map have been influenced by the objects that are being shown.
In other words, all the land use areas look alike, and all the roads look alike. When looking at the map, the viewers
don’t know anything about the roads they are seeing; only that there is a road of a certain shape in a certain area.

But the whole strength of GIS is that all the objects that are visible on the map also have attributes. Maps in a GIS
aren’t just pictures. They represent not only objects in locations, but also information about those objects.

The goal for this lesson: To learn about the structure of vector data and explore the attribute data of an object

3.1.1 Follow Along: Viewing Layer Attributes

It’s important to know that the data you will be working with does not only represent where objects are in space, but
also tells you what those objects are.

From the previous exercise, you should have the protected_areas layer loaded in your map. If it is not loaded,
then you can find the protected_areas. shp ESRI Shapefile format dataset in directory exercise_data/
shapefile.

The polygons representing the protected areas constitute the spatial data, but we can learn more about the protected
areas by exploring the attribute table.

1. In the Layers panel, click on the protected_areas layer to select it.

2. In the Layer menu, click the Open Attribute Table 1yyton (also accessible from top toolbars buttons). This will
open a new window showing the attribute table of the protected_areas layer.
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|L-\

\
y o f LT E & D P E = A &
full_id osm_id osm_type boundary is_in leisure name type wikidata
1/ 12855697 2855697 relation protected_a... Western Ca... nature_reser... Bontebok N... boundary Q892884
2 w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... NULL NULL

1

T show All Features _

Next, let’s see how a record in the attribute table is linked to a polygon feature that we see on the Map Canvas.

wil

en:Bc

A row is called a record and is associated with a feature in the Canvas Map, such as a polygon. A column is
called a field (or an attribute), and has a name that helps describe it, such as name or id. Values in the cells
are known as attribute values. These definitions are commonly used in GIS, so it is good to become familiar

with them.

In the protected_areas layer, there are two features, which are represented by the two polygons we see

on the Map Canvas.

Note: In order to understand what the fields and attribute values represent, one may need to find documen-
tation (or metadata) describing the meaning of the attribute values. This is usually available from the creator

of the data set.

1. Go back to the main QGIS window.

JR—

2. In the Edit » Select menu, click on the TJ?: Select Feature(s) button.

3. Make sure the protected_areas layer is still selected in the Layers panel.

4. Move your mouse to the Map Canvas and left click on the smaller of the two polygons. The polygon will turn

yellow indicating it is selected.
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5. Go back to the Artribute Table window, and you should see a record (row) highlighted. These are the attribute
values of the selected polygon.

Q protected_areas ©: Features Total: 2, Filtered: 2, Selected: 1 - [l *

/ 2 B 0§ LT ES P PE EDe

full id osm id 0sm type boundary is in leisure name tvpe wikidata Wi

) r2855697 protected_a... |Western Ca... |nature_reser... |Bontebok M... |boundary (892884
2/w187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Mat... NULL NULL NULJ
L) L3

| 7 show All Features _ 2|8
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You can also select a feature using the Attribute Table.

1. In the A#tribute Table window, on the far left, click on the row number of the record that is currently not

selected.
( protected_areas : Features Total: 2, Filtered: 2, Selected: 1 - O X
/ < ® 08 TV E S P P E = Fe
full id osm id osm type boundary is in leisure name type wikidata Wi
i) r2855697 protected_a... |[Western Ca... [nature_reser...
187055916 187055916 way protected_a... Western Ca... nature_reser... Marloth Nat... NULL NULL NULJ

4

T show All Features _

2. Go back to the main QGIS window and look at the Map Canvas. You should see the larger of the two polygons
colored yellow.
3. To deselect the feature, go to the Attribute Table window and click on D..-_f] Deselect all features from the layer ¢y,

Sometimes there are many features shown on the Map Canvas and it might be difficult to see which feature is selected
from the Attribute Table. Another way to identify the location of a feature is to use the Flash Feature tool.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Flash Feature and watch the Map Canvas.

() protected_areas : Features Total: 2, Filte

J Q ® 0§

full id osm id osm type
1

2 w1870559

Select All

Copy Cell Content
Zoom to Feature
Pan to Feature

Flash Feature

Open Form

You should see the polygon flash red a few times. If you missed it, try it again.
Another useful tool is the Zoom to Feature tool, that tells QGIS to zoom to the feature of interest.

1. In the Attribute Table, right-click on any cell in the row that has the attribute value r2855697 for the field
full_id.

2. In the context menu, click on Zoom to Feature
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0 protected_areas @ Features Total: 2, Fi

¥ [ | -
¥ ) El

S F

full id osm id osm tvi

JOCCo0T

il r23855697 -
Select All

2/ w1870559
Copy Cell Content

Zoom to Feature

Pan to Feature

Flash Feature

Open Form

Look at the Map Canvas. The polygon should now occupy the extent of the Map Canvas area.

You may now close the attribute table.

3.1.2 Try Yourself: Exploring Vector Data Attributes

1. How many fields are available in the rivers layer?
2. Tell us a bit about the t own places in your dataset.

3. Open the attribute table for the places layer. Which field would be the most useful to represent in label form,
and why?

Answer
* There should be 9 fields in the rivers layer:
1. Select the layer in the Layers panel.
2. Right-click and choose Open Attribute Table, or press the button on the Attributes Toolbar (it can be
enabled from View » Toolbars menu).
3. Count the number of columns.

A quicker approach could be to double-click the rivers layer, open the Layer properties » Fields tab, where you
will find a numbered list of the table’s fields.

* Information about towns is available in the places layer. Open its attribute table as you did with the rivers layer:
there are two features whose place attribute is set to town: Swellendam and Buffeljagsrivier. You can add
comment on other fields from these two records, if you like.

e The name field is the most useful to show as labels. This is because all its values are unique for every object
and are very unlikely to contain NULL values. If your data contains some NULL values, do not worry as long
as most of your places have names.
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3.1.3 In Conclusion

You now know how to use the attribute table to see what is actually in the data you're using. Any dataset will only
be useful to you if it has the attributes that you care about. If you know which attributes you need, you can quickly
decide if you're able to use a given dataset, or if you need to look for another one that has the required attribute data.

3.1.4 What’s Next?

Different attributes are useful for different purposes. Some of them can be represented directly as text for the map
user to see. You'll learn how to do this in the next lesson.

3.2 Lesson: Labels

Labels can be added to a map to show any information about an object. Any vector layer can have labels associated
with it. These labels rely on the attribute data of a layer for their content.

The goal for this lesson: To apply useful and good-looking labels to a layer.

3.2.1 Follow Along: Using Labels

First, ensure that the “2k=! button is visible in the GUI:
1. Go to the menu item View » Toolbars

2. Ensure that the Label Toolbar item has a check mark next to it. If it doesn’t, click on the Label Toolbar item
to activate it.

3. Click on the places layer in the Layers panel so that it is highlighted
4. Click on the ‘stz toolbar button to open the Labels tab of the Layer Styling panel
5. Switch from No Labels to ‘2k=| Single Labels

You'll need to choose which field in the attributes will be used for the labels. In the previous lesson, you decided
that the name field was the most suitable one for this purpose.

6. Select name from the Value list:
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Layer Styling )
o places =

=1 Single Labels - ||
(g

Value |abc name ~ || E

-

abe i abe abc . J

Text

Font | MS ShellDig 2 | S

Style Regular = @.
uE|sl€ B E 1€

Size | 10.0000 | &
Points | S

coor | (GG - <.

Dpaﬂtyl __l IDD.D E‘n"u -

1. Favorites v | 8
= Save Settings...

| e | Live update Apply

7. Click Apply

The map should now have labels like this:

3.2. Lesson: Labels 73



QGIS Training Manual

() *basic_map - QGIS 3efaefidf1 - [m] x
Project Edit View Layer Settings Plugins Vector Raster Database Mesh Progessing Help

DeERRY ([rreRPPr QiR LIOR (& -H-B-H-EERI =~ 0~

M@\ A WD - N . e T B T T L]
Browser =165 Layer Styling @
QET’EI‘O |.f‘plaoes vl
= /¢ Favorites -| i Single Labels - | \E|

» 5 QGIS-Training-Datate | |[g]
Value | ab< riame -

~ [ QGIS-Training-Data\s
SRR ISR

b [ styles
Font  |Ms Shel Dig 2 MK =S

| abe

3 Q basic_map
1" Spatial Bookmarks
[ Project Home
[¢] Home
[
" GeoPackage
f SpatiaLite
@ postGls
P mssaL
& pe2
B wms wmTS
ﬂ Wector Tiles
I XVZ Tiles
B wcs
) WFS / OGC AP| - Feature
) ows
& ArcGisMapServer
p=4

NP AP
4 »
Layers (=15
|i“@ ® T &~ »
v| @ places
v roads
v rivers
v| M buitdings
v . ‘water

v . protected_areas
v landuse

Style | Regular ME=E
u&s € 8l&|lr&
Size | 10.0000 BESE
| Paints - | S
cor [ - =,
Opacity m— o |2 S

avorites :i
| O Faverite: al-| 2

v vy owow

E [cave settings..|
(0][e] v Lveupdate | Aoy |

| @ Type to locate (ctl+k) Coordinate| 20,5409,-33.9529 W Scale 1:59610 v | (@ Magnifier | 100% |2] Rotaton [0.0° 2| W/Render @ EpsGiazes @

3.2.2 222 Follow Along: Changing Label Options

Depending on the styles you chose for your map in earlier lessons, you might find that the labels are not appropriately
formatted and either overlap or are too far away from their point markers.

Note: Above, you used the ‘sl button in the Label Toolbar to open the Layer Styling panel. As with Symbology,
the same label options are available via both the Layer Styling panel and the Layer Properties dialog. Here, you'll use
the Layer Properties dialog.

1. Open the Layer Properties dialog by double-clicking on the places layer
2. Select the ‘=E<| Labels tab

3. Make sure Zext is selected in the left-hand options list, then update the text formatting options to match those
shown here:
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@ Layer Properties - places | Labels

Information
Source

: Symbology
Labels
D Masks

o -
. Diagrams
E Fields

E Attributes Form

Joins

ﬂ Auxiliary Storage
{;@ Actions
- Display

Rendering

Variables

E Metadata
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QGIS Server
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W e

4. Click Apply

=1 Single Labels

Value | abc name

w Text Sample

Lorem Ipsum

Larem Ipsum

abe Text
2% Farmatting
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abc! Mask

. Background
- Shadow
ape Callouts
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=
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# | |usesw | v | (B |- -

Text
Font |Arial Vl E,
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Size | 13.0000 A ER
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That font may be larger and more familiar to users, but its readability is still dependent on what layers are
rendered beneath it. To solve this, let’s take a look at the Buffer option.

5. Select Buffer from the left-hand options list

6. Select the checkbox next to Draw text buffer, then choose options to match those shown here:

3.2. Lesson: Labels

75



QGIS Training Manual

@ Layer Properties - places | Labels

Q

{@be| Labels

abe

i
ujuj

7. Click Apply

4
| =1 Single Labels - | |E|
= Value |ib< name - | |E|
w Text Sample
Lorem Ipsum
|Larem Tpsum |E| |1:50810 | ¢ | |§|E| | |E|
abe Text Buffer —
2% Formatting V| Draw textbuffer (=],
@8 puffer Size | 1.0000 |:| e
abc) Mask
. Background |Mi||imeters - | E-
:.f Shadow e | |:| a
/ Callouts

1':0 Placement

“ Rendering

V| Color buffer's fil

Opacity 1| 100.0 % | €

Pen join style | B Bevel - | LEN
Blend mode |Normal - | @
Draw effects
oK | | cancel || Apply [ Help |

You'll see that this adds a colored buffer or border to the place labels, making them easier to pick out on the

map:
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Now we can address the positioning of the labels in relation to their point markers.
8. Select Placement from the left-hand options list

9. Select Around point and change the value of Distance to 2 . 0 Millimeters:
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10. Click Apply

You'll see that the labels are no longer overlapping their point markers.

3.23 Follow Along: Using Labels Instead of Layer Symbology

In many cases, the location of a point doesn’t need to be very specific. For example, most of the points inthe places
layer refer to entire towns or suburbs, and the specific point associated with such features is not that specific on a large
scale. In fact, giving a point that is too specific is often confusing for someone reading a map.

To name an example: on a map of the world, the point given for the European Union may be somewhere in Poland,
for instance. To someone reading the map, seeing a point labeled European Union in Poland, it may seem that the
capital of the European Union is therefore in Poland.

So, to prevent this kind of misunderstanding, it’s often useful to deactivate the point symbols and replace them
completely with labels.

In QGIS, you can do this by changing the position of the labels to be rendered directly over the points they refer to.
1. Open the ‘22| Labels tab of the Layer Properties dialog for the places layer
2. Select the Placement option from the options list

3. Click on the Offset from point button
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This will reveal the Quadrant options which you can use to set the position of the label in relation to the point
marker. In this case, we want the label to be centered on the point, so choose the center quadrant:
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4. Hide the point symbols by editing the layer Symbology as usual, and setting the size of the Marker size to 0 . 0:

3.2. Lesson: Labels
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5. Click Apply and you’ll see this result:
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If you were to zoom out on the map, you would see that some of the labels disappear at larger scales to avoid
overlapping. Sometimes this is what you want when dealing with datasets that have many points, but at other times
you will lose useful information this way. There is another possibility for handling cases like this, which we’ll cover

in a later exercise in this lesson. For now, zoom out and click on the button in the toolbar and see what happens.

3.24 Try Yourself: Customize the Labels

* Reset the label and symbol settings to have a point marker and a label offset of 2 . 0 Millimeters.

Answer

Your map should now show the marker points and the labels should be offset by 2mm. The style of the markers and
labels should allow both to be clearly visible on the map:
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* Set the map to the scale 1: 100000. You can do this by typing it into the Scale box in the Status Bar. Modify
your labels to be suitable for viewing at this scale.

Answer

One possible solution has this final product:
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To arrive at this result:

e Use a font size of 10

* Use an around point placement distance of 1.5 mm

¢ Use a marker size of 3.0

mm

* In addition, this example uses the Wrap on character option:

3.2. Lesson: Labels
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* Enter a space in this field and click Apply to achieve the same effect. In our case, some of the place names
are very long, resulting in names with multiple lines which is not very user friendly. You might find this setting
to be more appropriate for your map.

84 Chapter 3. Module: Classifying Vector Data



QGIS Training Manual

3.2.5

Follow Along: Labeling Lines

Now that you know how labeling works, there’s an additional problem. Points and polygons are easy to label, but
what about lines? If you label them the same way as the points, your results would look like this:
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We will now reformat the roads layer labels so that they are easy to understand.
1. Hide the places layer so that it doesn’t distract you
2. Activate Single Labels for the roads layer as you did above for places
3. Set the font Size to 10 so that you can see more labels
4. Zoom in on the Swellendam town area

5. In the Labels tab’s Placement tab, choose the following settings:
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@ Layer Properties - roads | Labels x
Q =1 Single Labels = | |¢' |
Value |ib< name -t | | & |
w Text Sample
Lorem Ipsum
{abe| Labels _— B b’
|Lorem Ipsum | 4 | | 1:8880 - | |ﬁ;|’| | |+
abc -
abe Text Placement
2% Farmatting =
- 8be Buffer
= abc) Mask (®) Paralel () Curved () Horizontal
=0 . Background
|
- Shadow
= Callouts
/* Allowed positions Above line || On line Below line @
#y¥ Placement
‘( Rendering Line orientation dependent position
(v} Distance | 0.0000 s €&
Millimeters hd L
Repeat | No repeat |:| @.
| Points - &
Qverrun feature |No OWErrun |:| E.
|Mil|imeters - |
v Geometry generator
l/
¥ -
= | style - | oK || cancel | | Apply | [ Help |
You'll probably find that the text styling has used default values and the labels are consequently very hard to
read. Update the Text to use a dark-grey or black Color and the Buffer to use a light-yellow Color.
The map will look somewhat like this, depending on scale:
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You'll see that some of the road names appear more than once and that’s not always necessary. To prevent this
from happening:

6. In the Labels tab of the Layer Properties dialog, choose the Rendering option and select Merge connected lines
to avoid duplicate labels as shown:
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@ Layer Properties - roads | Labels

=1 Single Labels -
Information Value | abc name - || &

w Text Sample

g

Source
Symbology Larem Ipsum
Labels b
Lorem Ipsum % | | 1:8860 - | | B~ v
D Masks o Rendering
¥ (4] - -
- + . - a
¢ Diagrams s Farmatting
abe B ffer Pixel size-based visibility (Jabels in map units) E,
E Fields abc) pqask
Minimum 3 px = L
Background
E Attributes Form . g 5
J Shadow Maximurn 10000 px - L
Joins }” Callouts
\ .:’ Placement Label zindex | 0,00 - E.
e i uxiliary Storage / Rendering Show all labels for this layer (induding colliding labels)
@ . Data defined
o Actions
) Show label 4= | Alwaysshow L
- Display Show upside-down labels
: ® never | | when rotation defined always
Rendering
o Featu i
Variables bt re options
~ Label every part of multi-part features
H Metadata vea e E’
v Merge connected lines to avoid duplicate labels
ﬁ Dependencies Limit number of features to be labeled to
Legend 2000 v
Suppress labeling of features smaller than
IE QGls
5.00 mm -
B oigitizing -
Style * 0K, Cancel Apply Help

7. Click OK
Another useful function is to prevent labels being drawn for features too short to be of notice.

8. In the same Rendering panel, set the value of Suppress labeling of features smaller than ... to 5.00 mm and
note the results when you click Apply

Try out different Placement settings as well. As we’ve seen before, the Horizontal option is not a good idea in
this case, so let’s try the Curved option instead.

9. Select the Curved option in the Placement panel of the Labels tab

Here’s the result:
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As you can see, this hides some labels that were previously visible, because of the difficulty of making some of them
follow twisting street lines while still being legible. It makes other labels much more useful since they track the roads
rather than float in space between them. You can decide which of these options to use, depending on what you think
seems more useful or what looks better.

3.2.6 Follow Along: Data Defined Settings

1. Deactivate labeling for the roads layer

2. Reactivate labeling for the places layer

3. Open the attribute table for places via the button

It has one field which is of interest to us now: place which defines the type of urban area for each record.
We can use this data to influence the label styles.

4. Navigate to the Text panel in the places Labels panel

5. Click the \= button next to the Italic text button beneath Style and select Edit... to open the Expression String
Builder:
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@ Expression String Builder

Expression Function Editor

= L= =~ (e

Expected format: bool [1=True|0=False]

Preview:

Feature < Mational Park Reception & Shop | ~

&, Search...

T T T T T YT YT T YTTYTTTTTTYTTTTTE

symbol_color
value
Aggregates
Arrays

Color
Conditionals
Conversions
Date and Time
Fields and Values
Files and Paths
Fuzzy Matching
General
Geometry

Map Layers
Maps

Math

Operators
Rasters

Record and Attributes
String

User expressions
Variables

Recent (generic)

Show Help

Ok Cancel Help

6. Under Fields and Values, double click on place and then click All Unique. This will list all unique values of

the place field of this layer. Add a = in the text editor and then double click on t own.

Alternatively, you can type: "place"

7. Click OK twice:

= 'town' directly in the text editor.

Q@ Expression String Builder

Function Editor

B L
o "town’

Expression

= e - L= e
Expected format: bool [1=True|0=False]
Feature «Mational Park Reception & Shop | ~

Preview: 0

&, Search...

{d vy v v ¥vw¥vovw

rF T T T rorw

symbol_color
value
Aggregates
Arrays

Color

Conditienals
Conversions
Date and Time
Fields and Values
abe fyll_id
abc psm_id
abc gsm_type
abc 5 _in
abc name
abc place
abc sagns_id
abc wikidata
abe wikipedia
Files and Paths
Fuzzy Matching
General
Geometry
Map Layers
Maps
Math

Show Values

group field

Double-click to add field name to expression
string.

Right-Click on field name to open context
menu sample value loading options,
Loading field values from WF5 layers isn't
supported, before the layer is actually
inserted, ie. when building queries.

Values | L Search..
All Unique 10 Samples
hamlet
locality
suburb
town
Ok Cancel Help

Notice that the labels for all places whose place field matches t own are displayed in italics.
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3.2.7 Try Yourself: Using Data Defined Settings

Note: We're jumping ahead a bit here to demonstrate some advanced labeling settings. At the advanced level, it’s
assumed that you’ll know what the following means. If you don’t, feel free to leave out this section and come back

later when you’ve covered the requisite materials.

1. Open the Attribute Table for places

2. Enter edit mode by clicking the i button

A=l
=

3. Add a new column with the ll-* button

4. Configure it like this:
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(2} Add Field X
Name FONT _SIZE

Comment

Type Decimal number (real) -

Provider type double
Length 3

Ll

qk

Precision 1

K Cancel

5. Use this to set custom font sizes for each different type of place (each key in the place field)

Answer

1. Still in edit mode, set the FONT__SIZE values to whatever you prefer. The example uses 1 6 for towns, 14 for
suburbs, 12 for localities, and 10 for hamlets.

2. Remember to save changes and exit edit mode
3. Return to the Text formatting options for the places layer and select FONT_SIZE in the A#utribute field of

the font size \= data defined override dropdown:

@ “basic_map - QG aeB3df1 — [m] ® « Re
| ) Layer Properties - places | Labels * « Re
Q 1 = v i [
Q = Single Labels - [ @)= fel
@ irrormation Value [ abc name - (e
w Text Sample
I :{4:\\ Source
Lorem Ipsum
Lorem Ipsum | 135423 |~ | By v
b Text Text 3
Diagrarms % Formatting  Font  |Arial -
5 Buffer
E Fields B8 Mosk style  |Regular - .
Background v
BE] uibutes Form [ uals a Bl & [
J Shadow
abo Size 13,0000 = %|
Joins 7 Callouts
. % Placement Points - -
Y Awiry Storage 7 Rendering | Description... Agsrivier
coor | Store Data in the Praject
B actions
= Opadty |1 100.0 % - Attribute Field N
0 oicpiy e dle : full id (string)
. <, Favorites a@ - Expression osm_id  (string)
& Rendering
Variable | osmtype (string)
Variables Edit... isin  (string)
‘ ~ Paste name  (string)
Bl veteoa Assistant... place  (string)
ﬁ Dependencies sagns_id  (string)
wikidata (string)
Legend wikipedia (string)

FONT_SIZE (double)

& qais server

Save Settings...

BsY

ﬂ [

Style  ~ oK | Cancel Apply Help

APE

.

Q Type to locate (Cirl+) Toagles the editing st Coordinate | 20.4135,-34.0203 | Scale| 1:35423 |~ | @ Magnifier | 100% 2| Rotation |0.0° +| V|Render @ Ersia3e @

Your results, if using the above values, should be this:
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3.2.8 Further Possibilities With Labeling

We can’t cover every option in this course, but be aware that the Label tab has many other useful functions. You
can set scale-based rendering, alter the rendering priority for labels in a layer, and set every label option using layer
attributes. You can even set the rotation, XY position, and other properties of a label (if you have attribute fields
allocated for the purpose), then edit these properties using the tools adjacent to the main Layer Labeling Options
button:

ol - Aok R

(These tools will be active if the required attribute fields exist and you are in edit mode.)

Feel free to explore more possibilities of the labeling system.
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3.2.9 In Conclusion

You've learned how to use layer attributes to create dynamic labels. This can make your map a lot more informative
and stylish!

3.2.10 What’s Next?

Now that you know how attributes can make a visual difference for your map, how about using them to change the
symbology of objects themselves? That’s the topic for the next lesson!

3.3 Lesson: Classification

Labels are a good way to communicate information such as the names of individual places, but they can’t be used for
everything. For example, let us say that someone wants to know what each 1anduse area is used for. Using labels,
you would get this:

This makes the map’s labeling difficult to read and even overwhelming if there are numerous different landuse areas
on the map.

The goal for this lesson: To learn how to classify vector data effectively.

3.3.1 Follow Along: Classifying Nominal Data

1. Open the Layer Properties dialog for the 1anduse layer
2. Go to the Symbology tab
3. Click on the dropdown that says Single Symbol and change it to Categorized:
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"i Information

‘:{:\? Source

& symbology

€€ Labels

B Masks

- .
. [MELEINE

N7 3D View

E Fields

Attributes
Form

Joins

% Auxiliary
< B storage

@ Actions
- Display

4. In the new panel, change the Value to 1anduse and the Color ramp to Random colors

5. Click the button labeled Classify

'rf Information

:-'C\ Source

Q’ Ssymbology

€= Labels

B Masks

Diagrams
W# 3D View

E Fields

Attributes
Form

Joins

L Auxiliary
< B Storage

@ Actions
- Display

3

6. Click OK

| = Categorized

= Categorized

Layer Properties - landuse | Symbology

Value |

Symbol ||

Color ramp |

Random colors

symbol = Value Legend

P Layer Rendering
@Help || style -

- |

Layer Properties - landuse | Symbology

| Classify | |E| |E| | Delete All |

|Advanced ~ |

| /Apply || % cancel |[ & OK ]

value abc landuse ~|| €]
symbol || [+
Color ramp | Random colors |'|
Symbol = Value Legend

v [l cemetery cemetery

v/ [ conservation conservation

v/ [l farmland farmland

v/ [l forest forest

v/ [ grass grass

v Il industrial industrial

v/ [l orchard orchard

v/ [ reservoir reservoir

v/ [l residential residential

v/ [l village _green village green

v [ vineyard vineyard

v [ all other values

| Classify | |E| |E| | Delete All |

» Layer Rendering
@Help || stle -

- |

You'll see something like this:

|Advanced - |

 JApply || ®cancel || JoK |
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7. Click the arrow (or plus sign) next to 1anduse in the Layers panel, you'll see the categories explained:
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Layers (&) )
o [ ® T &~5 & [
» v o places -
v| ] buildings
v — roads
water [
v rivers
* W .~ landuse
v . cemetery
. conservation

B farmland

. Forest

I grass
B industrial

I orchard
. reservoir

B residential

I village_green
"] vineyard

e e e e e e L

Now our landuse polygons are colored and are classified so that areas with the same land use are the same
color.

8. If you wish to, you can change the symbol of each landuse area by double-clicking the relevant color block in
the Layers panel or in the Layer Properties dialog:
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Symbol Selector

(%]
Unit | Millimeters - |
Opacity ~1/100,0 % |:_|
Color | H
| ©. Favorites a|~| &
| Z/ BN

gradient gray 3 fill hashed black/  hashed black,

plasma
|| B |save Symbol... | | Advanced ~|
| @Help | | % cancel H « oK ]

Notice that there is one category that’s empty:
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Layer Properties - landuse | Symbology B

= Categorized -

@ information Value a< landuse ~|[g

Symbol [ ] |+

‘:{:\‘_- Source

& symbology

Color ramp Random colors M

symbol = Value Legend
€3 Labels v [ cemetery cemetery
v/ [l conservation conservation
EED Masks v/ [l farmland farmland
. v/ [l forest forest
, Diagrams v/ [ grass grass
v Il industrial industrial
\*’ 3D View v [l orchard orchard
v [ reservoir reservoir
E Fields v/ [l residential residential
Attributes v/ [l v?llage_green v?llage_green
v [ vineyard vineyard

Form
all other values

<
|

Joins

L Auxiliary
< B storage

{;'.-® Actions
@ Display —| @Help Style - « Apply || % cancel

Classify | = | = | Delete All Advanced ~
P Layer Rendering

This empty category is used to color any objects which do not have a landuse value defined or which have a NULL
value. It can be useful to keep this empty category so that areas with a NULL value are still represented on the map.
You may like to change the color to more obviously represent a blank or NULL value.

Remember to save your map now so that you don’t lose all your hard-earned changes!

3.3.2 Try Yourself: More Classification

Use the knowledge you gained above to classify the buildings layer. Set the categorisation against the building
field and use the Spectral color ramp.

Note: Remember to zoom into an urban area to see the results.

3.3.3 Follow Along: Ratio Classification

There are four types of classification: nominal, ordinal, interval and ratio.

In nominal classification, the categories that objects are classified into are name-based; they have no order. For
example: town names, district codes, etc. Symbols that are used for nominal data should not imply any order or
magnitude.

* For points, we can use symbols of different shape.
* For polygons, we can use different types of hatching or different colours (avoid mixing light and dark colours).

* For lines, we can use different dash patterns, different colours (avoid mixing light and dark colours) and different
symbols along the lines.

In ordinal classification, the categories are arranged in a certain order. For example, world cities are given a rank
depending on their importance for world trade, travel, culture, etc. Symbols that are used for ordinal data should
imply order, but not magnitude.
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¢ For points, we can use symbols with light to dark colours.
* For polygons, we can use graduated colours (light to dark).
* For lines, we can use graduated colours (light to dark).

In interval classification, the numbers are on a scale with positive, negative and zero values. For example: height
above/below sea level, temperature in degrees Celsius. Symbols that are used for interval data should imply order and
magnitude.

* For points, we can use symbols with varying size (small to big).
* For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
 For lines, we can use thickness (thin to thick).

In ratio classification, the numbers are on a scale with only positive and zero values. For example: temperature above
absolute zero (0 degrees Kelvin), distance from a point, the average amount of traffic on a given street per month,
etc. Symbols that are used for ratio data should imply order and magnitude.

¢ For points, we can use symbols with varying size (small to big).
* For polygons, we can use graduated colours (light to dark) or add diagrams of varying size.
¢ For lines, we can use thickness (thin to thick).

In the example above, we used nominal classification to color each record in the 1landuse layer based on its Lan—
duse attribute. Now we will use ratio classification to classify the records by area.

We are going to reclassify the layer, so existing classes will be lost if not saved. To store the current classification:
1. Open the layer’s properties dialog
2. Click the Save Style ... button in the Style drop-down menu.
3. Select Rename Current..., enter Land usage and press OK.
The categories and their symbols are now saved in the layer’s properties.

4. Click now on the Add... entry of the Style drop-down menu and create a new style named ratio. This will
store the new classification.

5. Close the Layer Properties dialog

We want to classify the landuse areas by size, but there is a problem: they don’t have a size field, so we’ll have to
make one.

1. Open the Attributes Table for the 1anduse layer.
2. Enter edit mode by clicking the §/ Toggle editing by yon

3. Add a new column of decimal type, called AREA, using the | £ New field button:

Add Field -

Name AREA
Comment
Type Decimal number (double) ~

Provider type FLOAT
# cancel | «/ OK

4. Click OK

The new field will be added (at the far right of the table; you may need to scroll horizontally to see it). However,
at the moment it is not populated, it just has a lot of NULL values.

To solve this problem, we will need to calculate the areas.
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o

1. Open the field calculator with the === button.

You will get this dialog:

() landuse — Field Calculator X

Only update 0 selected features

v | Create a new field Update existing field

Create virtual field
Qutput field name
Cutput field type | Binary object (BLOB) -

Cutput field length | 0 Precision 3
Expression Function Editor

2, se.. Show Help

row_number
Aggregates
Arrays

Color
Conditionals
Conversions
Date and Time
Fields and Values
Files and Paths
Fuzzy Matching
General
Geometry

Map Layers
Maps

Math

Operatars
Rasters

Record and Attnibu...
String

User expressions
Variables

Feature A F‘

r *F Y F ¥ ¥ ¥ ¥ F ¥ ¥ ¥ Y ¥ F ¥ ¥ FXFW

Preview:

OK Cancel Help

2. Check the oA Update existing fields
3. Select AREA in the fields drop-down menu

Field calculator %

Create a new field V| Update existing field

1.2 AREA -

4. Under the Expression tab, expand the Geometry functions group in the list and find $area

5. Double-click on it so that it appears in the Expression field
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landuse — Field Calculator S5

Create a new Field v Update existing Field
1.2 AREA -

Expression | Function Editor

|8 ol Q search... function $area
area -
$ > B . Returns the area of the current feature. The
» Date and Time ) )
» Fields and Values area calculated by this function respects both
» Files and Paths the current project's ellipsoid setting and area
» Fuzzy Matching unit settings. For example, if an ellipsoid has
» General been set for the project then the calculated
~ Geometry area will be ellipsoidal, and if no ellipsoid is
anale at_vertex set then the calculated area will be
planimetric.
area
azimuth Syntax
boundary
o bounds $area
=LA A L) [ bounds_height
bounds_width Examples
Feature |1 - I3 buffer
* $area - 42
Preview: 1312821.1395745648 buffer_by_m ~ $
@Help % cancel < oK
6. Click OK

7. Scroll to the AREA field in the attribute table and you will notice that it is populated with values (you may
need to click the column header to refresh the data).

Note: These areas respect the project’s area unit settings, so they may be in square meters or square degrees.

5. Press B to save the edits and exit the edit mode with ,ﬁ; Toggle editing
6. Close the attribute table
Now that we have the data, let’s use them to render the 1anduse layer.
1. Open the Layer properties dialog’s Symbology tab for the 1anduse layer
2. Change the classification style from Categorized to Graduated
3. Change the Value to AREA

4. Under Color ramp, choose the option Create New Color Ramp...:
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@ Layer Properties - landuse | Symbology *
Q = Graduated - |
Value |1-2 AREA = | | & |
Symbal | |'|
Legend format |%1- %2 | | Predision 4 |3| | Trim
‘ Symbology _
Colorramp | -
Labels | Classes | ] Invert Coler Ramp
i Random Color Ramp
Masks Symbol |V
] I Blues
Diagrams I Greens
Fields M Greys
. Magma
Attributes Form I | RdGy
I Reds
Jains
I |Spectra|
Auxiliary Storage . Viridis
All Color Ramps b
Actions
Create Mew Celor Ramp...
Display Edit Color Ramp...
- —] Save Color Ramp...
Rendering Mode |HEHEqua1‘cmmmc, T Classes | 5 =
| Classify | |¥| |;| | Delete Al | | Advanced '|

Temporal

V| Link dass boundaries
Variables
P Layer Rendering

=

Metadata

(s ) o [ con |[ ooy |[ _reb |

5. Choose Gradient (if it’s not selected already) and click OK. You will see this:
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() Select Color Ramp >

Color 1 | (N |~ color 2 | IR |~/ Type | Continuous B

] ]
w Gradient Stop -
Relative position | 0.0 %G Delete Stop
5 * .
m|® Z o B N o :
Standard colors * | = 100%  |w

100% |«

G 0 =
B 255 A
[ ] | | Opadty S oo -
o | = HTML notation | 0000
Current

w Flot

Information oK Cancel Help

You'll be using this to denote area, with small areas as Color 1 and large areas as Color 2.
6. Choose appropriate colors

In the example, the result looks like this:
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(&) Select Color Ramp >

Color 1 - Color 2 _ - Type | Continuous =
| I |~ | O | o | |

w Gradient Stop |~

Relative position | 0.0 % = | Delete Stop

CREERE-REA Ow RV v [}

Standird colors “H | Os Y O e -
—‘ - -

. o I o

1
[ | - | Opadty T lw00% |2

|£"E| HTML notation | #h2dfaa v |

ot o eI
Y OO ]

Information oK ] | Cancel | | Help

7. Click OK
8. You can save the colour ramp by selecting Save Color Ramp... under the Color ramp tab. Choose an appropriate
name for the colour ramp and click Save. You will now be able to select the same colour ramp easily under All
Color Ramps.
9. Under Mode choose H_H Equal Count (Quantile)
10. Click Classify

Now you will have something like this:
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@ Layer Properties - landuse | Symbelogy x
Q = Graduated - |
= value 12 anea - [g]
Symboal | |:|

Legend format | %1 - %2 | | Precision 0 |$| V! Trim

‘ Symbology -
Colorramp | . S——

abe -

| Classes | Histogram

e Symbol ™ Values Legend
v 131.30 - 10512.65 131-10313
v 10312.65 - 35728.06 10313 - 35728
= vl 35728.06 - 132271.73 35728 - 132272
= vl 132271.73 - 362220.57 132272 - 362221
— v 362220.57 - 112894046,06 362221 - 112894046
=0
Mode |H:EHEquaI Count (Quantile) ~ | Classes |5 3|
| Classify | |¥| |;| | Delete Al | | Advanced '|
V| Link class boundaries
O
B Layer Rendering
| stye - ok || cancel || Appy || hHep |
Leave everything else as-is.
11. Click OK:

Bontebok &¥Shop)
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334 Try Yourself: Refine the Classification

¢ Change the values of Mode and Classes until you get a classification that makes sense.

Answer

The settings you used might not be the same, but with the values Classes = 6 and Mode = Natural Breaks (Jenks) (and
using the same colors, of course), the map will look like this:

“Boniebok National|Rark[Recepion/& Shoplt

3.3.5 Follow Along: Rule-based Classification

It’s often useful to combine multiple criteria for a classification, but unfortunately normal classification only takes one
attribute into account. That’s where rule-based classification comes in handy.

In this lesson, we will represent the 1anduse layer in a way to easily identify Swellendam city from the other
residential area, and from the other types of landuse (based on their area).

1. Open the Layer Properties dialog for the 1anduse layer
2. Switch to the Symbology tab
3. Switch the classification style to Rule-based

QGIS will automatically show the rules that represent the current classification implemented for this layer. For
example, after completing the exercise above, you may see something like this:
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@ Layer Properties - landusze | Symbolo: *
y P Y gy
- [= Rule-based -
q Information Label Rule Min, scale Max.
v 131 - 101924 "AREA" »= 131.299349 AND "AREA" <= 101924.439748
J\-:\a_ TrnmEz v 101924 - 300418 "AREA" » 101924.495748 AND "AREA" <= 309417.846808
: v . 300418 - 839955 "AREA" » 309417.846808 AND "AREA" <= 839954.777508
v . 839955 - 1578789 "AREA" » 839954,777508 AND "AREA" <= 1578788.863263
v . 1578789 - 34452227 "AREA" » 1578788.863263 AND "AREA" <= 34452226.958486
£ Labels v . 34452227 - 112884046 "AREA" » 34452226,958486 AND "AREA" <= 112894046.060455
LD Masks
- . _
. Diagrams 7 5
E Eiskis g S E Symbol Levels. ..
: Refine Selected Rules
E Attributes Form

p Layer Rendering

Joins Style - oK Cancel Apply Help

4. Click and drag to select all the rules

5. Use the "= Remove selected rules 1101 to remove all of the existing rules

Let’s now add our custom rules.

1. Click the ':II-I:I-I:| Addrule by tton
2. The Edit rule dialog then appears

3. Enter Swellendam city as Label

4. Click the € button next to the Filter text area to open the Expression String Builder

5. Enter the criterion "name" = 'Swellendam' and validate

Expression String Builder x

Expression | Function Editor

] L Q search... group field

= 'Swellendam' Conditionals =

Double-click to add field name to expression string.

b
b G i
» Cﬁ:::;lsmns Right-Click on field name to open context menu sample value
» Date and Time loading options.
~ Fields and Values Notes
NULL - -
123 ogc_Ffid
ave Full_id Values | & search...
abc osm_id
< psm_type All Unique 10 Samples
»< landuse Fynbos Heights -
Gaikou Lodge
anc type Koloniesbos
ahe wikipedia Koornland
=0+ A w s boundary Marloth Nature Reserve
an< s in Railton
Feature 1 e > abe lefsure Swellendam
Preview: 0 e name:de - Wamakersbos -
@Help 3 Cancel

6. Back to the Edit rule dialog, assign it a darker grey-blue color in order to indicate the town’s importance in the
region and remove the border
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Label swellendam city =
e Filter "name" = 'Swellendam’ £ Test
Else Caktch-all For other features
Description
Scale range
v Symbol
o

M simple Fill

Unit Millimekers -
Opacity _11100.0 % -
Color [

-

@Help ¥ cancel

7. Press OK
8. Repeat the steps above to add the following rules:

1. Other residential label with the criterion "landuse" = 'residential' AND "name" <>
'Swellendam'. Choose a pale blue-grey Fill color

2. Bignon residential areas label with the criterion "1anduse" <> 'residential' AND "AREA"
>= 605000. Choose a mid-green color.

Layer Properties — landuse (basic) — Symbology 0

Q = Rule-based -

@ information * |Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name" = 'Swellendam’

:{_‘\\ Source v Other residenttial "landuse" = 'residential' AND "name" <> 'Swellendam’

v| [l Big non residential areas "landuse" <> 'residential' AND "AREA" >= 605000
& symbology

WF 3D View

Diagrams

-
'
o Z[|Z symbol Levels...

E Fields

E Attributes Form e Redering

Joins - | @Help Style - < Apply | % cCancel

These filters are exclusive, in that they exclude areas on the map (non-residential areas which are smaller
than 605000 (square meters) are not included in any of the rules).

3. We will catch the remaining features using a new rule labeled Small non residential areas. Instead of

a filter expression, Check the ® ' Else. Give this category a suitable pale green color.
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Label small non residential areas =
) Filter
(e Else Catch-all for other features

Description

Scale range
v| Symbol
o
simple Fill
Unit Millimeters -
Opacity _11100.0 % -
Color v

-

©@Help % Cancel

Your rules should now look like this:

Layer Properties — landuse (basic) — Symbology

Q = Rule-based -
@ information | Label Rule Min. Scale Max. Scale  Count Duplicate Count
v| [l swellendam city "name” = 'Swellendam’
a\:\\ Source v Other residenttial "landuse” = 'residential' AND "name" <> 'Swellendam'
v| [l Big non residential areas "landuse" <> 'residential' AND "AREA" >= 605000
d Symbology v Small non residential areas ELSE
€3 Labels
€D Masks
W@ 30 View
>
4 Diagrams
L 4| Z symbol Levels...
E Fields

E Attributes Form

b Layer Rendering

Joins - | @Help Style - «/ Apply || % cancel

9. Apply this symbology

Your map will look something like this:
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Om&

Now you have a map with Swellendam the most prominent residential area and other non-residential areas colored
according to their size.

3.3.6 In Conclusion
Symbology allows us to represent the attributes of a layer in an easy-to-read way. It allows us as well as the map reader

to understand the significance of features, using any relevant attributes that we choose. Depending on the problems
you face, you’ll apply different classification techniques to solve them.

3.3.7 What’s Next?

Now we have a nice-looking map, but how are we going to get it out of QGIS and into a format we can print out, or
make into an image or PDF? That’s the topic of the next lesson!
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CHAPTER
FOUR

MODULE: LAYING OUT THE MAPS

In this module, you’ll learn how to use the QGIS print layout to produce quality maps with all the requisite map
components.

4.1 Lesson: Using Print Layout

Now that you've got a map, you need to be able to print it or to export it to a document. The reason is, a GIS map
file is not an image. Rather, it saves the state of the GIS program, with references to all the layers, their labels,colors,
etc. So for someone who doesn’t have the data or the same GIS program (such as QGIS), the map file will be useless.
Luckily, QGIS can export its map file to a format that anyone’s computer can read, as well as printing out the map if
you have a printer connected. Both exporting and printing is handled via the Print Layout.

The goal for this lesson: To use the QGIS Print Layout to create a basic map with all the required settings.

4.1.1 Follow Along: The Layout Manager

QGIS allows you to create multiple maps using the same map file. For this reason, it has a tool called the Layout
Manager.

1. Click on the Project » Layout Manager... menu entry to open this tool. You'll see a blank Layout manager

dialog appear.
Layout Manager o]

v New from Template

Empty layout * || Create...

Open template directory User

@Help * Close

2. Under New from Template, select Empty layout and press the Create... button.

3. Give the new layout the name of Swellendam and click OK.
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4. You will now see the Print Layout window:

*Swellendam

Layout Edit View Items AddItem Atlas Settings
BRI [ & B b Uy | | ®]
ALPHT BBOLEE bH
o Lo P B P R R LR e [undoistery
A s Items (23]
i;) . ® =1 Item
q ]
L) -
I
04
d E Layout Item Properties Guides
q _: Layout (=)
T: w General Settings 1
=2
I _: Reference map -
8 _E w Guides and Grid
b 5
o '_E Grid spacing
e+ B 10,00 s mm -
a _: Grid offset
=
/:q: G x: 0,00 °
. mm -
Fé g y: 0,00 v
i _: Snap tolerance
= =
x: 238 mm y: 0 mm page: 1 35.6% v | LF

You could also create this new layout via the Project » New Print Layout... menu.

Whichever route you take, the new print layout is now accessible from the Project » Layouts » menu, as in the image
below.

Edit View Layer Settings Plugins Vector Raster Databa

" New cerl+N ;] g‘) g‘) &g

New from Template v
Open... Ctrl+0
Open From »
| Open Recent b
Close
= save Ctrl+s
|5 save As... Ctrl+Shift+s
Save To ’
Revert...
Properties... Ctrl+shift+P
Snapping Options...
Import/Export ¢
Iy New Print Layout... Ctri+P
") New Report...

4 Layout Manager...

swellendam
Exit QGIS ctrl+Q
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4.1.2 Follow Along: Basic Map Composition

In this example, the composition was already the way we wanted it. Ensure that yours is as well.

1. Right-click on the sheet in the central part of the layout window and choose Page properties... in the context
menu.

2. Check that the values in the Item Properties tab are set to the following:
* Size: A4
e Orientation: Landscape

Now you’ve got the page layout the way you wanted it, but this page is still blank. It clearly lacks a map. Let’s
fix that!

3. Click on the | £ A4V bygton,
With this tool activated, you will be able to place a map on the page.
4. Click and drag a box on the blank page:

Layout Edit View [tems AddIitem Atlas Settings

BRRoR & ®Rliglho e E® O ®- @~

o P B e R B B ttems B®
@ 3 ® =} ltem
Ty [e-
2| 3
] :
13 | =
I
a- Layout | Item Properties | Guides
I?{ E Item Properties @&
__....o -
U2
=
-
el
o -
- g
= ]
width: 289.104 mm height: 202.495 mm %:292.763 mm y: 206.154 mm page: 1 43.4% v |k

The map will appear on the page.

5. Move the map by clicking and dragging it around:
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*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRLNDB R SREEe o s T N

0 ltems =
a8 ltem

|0 |50 |1m | | |2un |25t: ‘30
vl b evon beron b b bl trrn b bvrac bbbl

(NN
L

Layout | ltem Properties | Guides

FA’ s Item Properties (=] E5]
&) - Map 1
|- BERER B =
IRYEE - .
q 3 ¥ Main Properties
|z scale 38108 | &
A- i " <
= - Map rotation 0,00 |,| <
== CRS | Use Project CRS ~ || &
& 2 | 4|
A] E: Draw map canvas items
3 2 ¥ Lavers =
1 item selected X:140.892 mm y: 101.247 mm page: 1 |43.4% - | O—

6. Resize it by clicking and dragging the boxes on the edges:

*Swellendam

Layout Edit View [tems AddItem Atlas Settings

BRULURODR Bemlghe o | B® 2 B~

300 Jtems
£ & ltem

| ] |50 |1o |150 |2u |250
oo bevac bbb b bovvoe b boror b bvern vl

Layout | ltem Properties | Guides

jf‘z Item Properties (E]E
8 Map 1
s RERER MNE =
3 | [~
q E w Main Properties
E Scale 38108 | &
A= . B -
o E Map rotation \D.DO |v| %
== CRS | Use Project CRS ~ || &
= (] L
A} 3—: Draw map canvas items
v |z - lamErs -
width: 270.196 mm height: 187.247 mm X:25.0069 mm y: 20.7374mm page: 1 |43.4% - | O—=

Note: Your map may look a lot different, of course! This depends on how your own project is set up. But not
to worry! These instructions are general, so they will work the same regardless of what the map itself looks
like.

7. Be sure to leave margins along the edges, and a space along the top for the title.

8. Zoom in and out on the page (but not the map!) by using these buttons:

HpEE
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& A
9. Zoom and pan the map in the main QGIS window. You can also pan the map using the lﬂ Move item content ¢q)]
The map view updates as you zoom in or zoom out.
10. If, for any reason, the map view does not refresh correctly, you can force the map to refresh by clicking the

E Refresh view button.

Remember that the size and position you’ve given the map doesn’t need to be final. You can always come back
and change it later if you’re not satisfied. For now, you need to ensure that you’ve saved your work on this map.
Because a Print Layout in QGIS is part of the main map file, you must save your project.

=]
11. Go to the Layout » Save Project. This is a convenient shortcut to the one in the main dialog.

4.1.3 Follow Along: Adding a Title

Now your map is looking good on the page, but your readers/users are not being told what’s going on yet. They need
some context, which is what you’ll provide for them by adding map elements. First, let us add a title.

) T
1. Click on the AddLabel 1y, ¢ton

2. Click on the page, above the map, accept the suggested values in the New Item Properties dialog, and a label
will appear at the top of the map.

3. Resize it and place it in the top center of the page. It can be resized and moved in the same way that you resized
and moved the map.

As you move the title, you'll notice that guidelines appear to help you position the title in the center of the page.

However, there is also a tool in the Actions Toolbar to help position the title relative to the map (not the page):
|IZ|
4. Click the map to select it

5. Hold in Shi ft on your keyboard and click on the label so that both the map and the label are selected.

I )
6. Look for the | Alieselected tems kft byygt0n and click on the dropdown arrow next to it to reveal the positioning

options and click Iil Align center:

e = | = X »
|3PP ltem Align Left
. i Align Center g
| Align Right
“7 Align Top

-2 Align Center Vertical
Layi - Align Bottom

Now the label frame is centered on the map, but not the contents. To center the contents of the label:
1. Select the label by clicking on it.

2. Click on the Item Properties tab in the side panel of the layout window.
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3. Change the text of the label to “Swellendam”:

Layout | Item Properties | Guides

Itemn Properties @
Label

¥ Main Properties

swellendam

Render as HTML

Insert an Expression...

v Appearance

Font =
Font color S -
Horizontal margin | 0.00 mm =

Vertical margin 0.00 mm -
Horizontal alignment
Left Center Right (® Justify
Vertical alignment
® Top Middle Bottom

Position and Size

>

b Rotation

> Frame

3 Background
b Item ID

4. Use this interface to set the font and alignment options under the Appearance section:
1. Choose a large but sensible font (the example will use the default font with a size of 36)
2. Set the Horizontal Alignment to Center.
You can also change the font color, but it’s probably best to keep it black as per the default.

5. The default setting is not to add a frame to the title’s text box. However, if you wish to add a frame, you
can do so:

1. In the Item Properties tab, scroll down until you see the Frame option.
2. Click the Frame checkbox to enable the frame. You can also change the frame’s color and width.

In this example, we won’t enable the frame, so here is our page so far:
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*Swellendam
Layout Edit View [tems AddItem Atlas Settings

BRLREB L @kiplL e @B O QS B, b » L »
i B i i | B e et L ] i et e L s 2x
= @ a8 ltem

| | Swellendam

Aol &

Swellendam

g v 71 Map1

I

[E —; Layout | Item Properties | Guides

!f? = Item Properties (E=]ES
g -

IPYEE

=

=.__n '—:

E

A [

X:173.218 mm y: -4.26947 mm page: 1 |43.4% n | (———

To make sure that you don’t accidentally move these elements around now that you’ve aligned them, you can
lock items into place:

1. Select both the label and the map items

Fii
2. Click the % Lock Selected Items 1yy¢to in the Actions Toolbar.

Note: Click the [@I Unlock All Ttems by tton in the Actions Toolbar to be able to edit the items again.

41.4 Follow Along: Adding a Legend

The map reader also needs to be able to see what various things on the map actually mean. In some cases, like the

place names, this is quite obvious. In other cases, it’s more difficult to guess, like the colors of the forests. Let’s add
a new legend.

1. Click on the 5 Add Leend pygeon
2. Click on the page to place the legend, accept the suggested values in the New Item Properties dialog,
3. Alegend is added to the layout page, showing layers symbology as set in the main dialog.

4. As usual, you can click and move the item to where you want it:
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*Swellendam

Layout Edit View Items AddIitem Aklas Settings

BRORER R eRREe ¢ B© 00 QR bbb > ®P -

v Resize to fit contents

|o |50 |1on |150 |2ﬂn | ‘250 ‘300 ltems =5
v bbb b boraoa b bvooo v brvoao b bl vl —
'{rj 1 @ 8 ltem
p = | | Legend
é 3 Swellendam v Swellendam
o 3 end
| % . [ trining_data buidings v O Map 1
T 4 [ craining,_data restaurants
@ = e p—— =
2- o i st Layout | Item Properties | Guides
!f;’ = * Item Properties =]
ears
3 watar Legend
!'_6 ] =Df:h(m arvas a8
= dus O ¥ Main Properties [
IFYEERR
] [ fami
A Wi Title |Legend | & |
-1 0 grass
] D industriat
=== Map [ EMap 1 ]
9 0 rusidensi
2= =z -m'::":rlm Wrap text on | |
I-n ; W seeyard
|| < — - Arrangement | 3= Symbols on Left - |
| 2

0 —
X:243.36 mm y: 29.2763 mm page: 1 |43.4% ~ |

4.1.5 Follow Along: Customizing Legend Items

Not everything on the legend is necessary, so let’s remove some unwanted items.

1. In the Item Properties tab, you’ll find the Legend items group.

2. Uncheck the L) Auto update box, allowing you to directly modify the legend items
3. Select the entry with buildings

4. Delete it from the legend by clicking the = button
You can also rename items.

1. Select a layer from the same list.

2. Click the @ Edit selected item properties button.
3. Rename the layers to Places, Roads and Streets, Surface Water, and Rivers.

You can also reorder the items:
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*Swellendam

Layout Edit View Items AddIitem Aklas Settings

BRORER R eRREe ¢ B© 00 QR bbb > ®P -

|o |50 |1on |150 |2ﬂn stn ‘300 ltems =5
b b bvrra bbb bvvoe b bveor oo bovoe vl o —
i 8 ltem

@

Aol &

) W 5(E
|\|||I\||||||||I|||
0]

:
2

Swellendam

L]
O swellendam
O 7] Map 1

<=

[Egend T O
Rbvers
B surface water
landuse

Layout | ltem Properties | Guides

!?A, Ex:t a
9 russeret Item Properties 3
i d
e .
E - =.:L:.... » Main Properties
= O ooy v Legend Items
q - Roads and streets
_ PMaces
= [ ot Jaarea | __ Auto update
A ~— Rivers
E M surface water
] ¥ 9 landuse
7 [ farmland
EE [ grass
o 3 M farect

[4]
X:242.75mm  y:-0.609924 mm page: 1 |43.4% - | (e

As the legend will likely be widened by the new layer names, you may wish to move and resize the legend and or map.
This is the result:

*Swellendam

Layout Edit View |[tems AddItem Atlas Settings

BRORDB R eBRke o @00 CE R > B O >

|o |50 |100 |150 |200 | ‘250 ‘300 ltems B®
tor b bevaoc b b b b b bovor b boalr breen v b

@ © [ item

p Swellendam ] Swellendam

m O 7] Map 1

| Layout | Item Properties =~ Guides
Layout

|

Legend
R
I surface wakar

» General Settings

E - e » Guides and Grid
s =
q = =x€lm 1 v Export Settings L
E [0 industrial
= I cscurcion Export resolution | 300 dpi 2|
- 5 cosarvaic
= |°- e o || Print as raster
B = i
ey Raads andstreces || Always export as vectors
o - Places
A} 8_: e || save world file
H 1 ¥ Resize Layout to Content b

Xx:237.87 mm y: 11.5885 mm page: 1 |43.4% = | (=
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4.1.6 Follow Along: Exporting Your Map

Note: Did you remember to save your work often?

Finally the map is ready for export! You’ll see the export buttons near the top left corner of the layout window:

o U5 princLayout; jneerfaces with a printer. Since the printer options will differ depending on the model of printer

that you’re working with, it’s probably better to consult the printer manual or a general guide to printing for
more information on this topic.

The other buttons allow you to export the map page to a file.

o g Bxportas Image, gives you a selection of various common image formats to choose from. This is probably the
simplest option, but the image it creates is “dead” and difficult to edit.

o [2f@ Bxportas SVG: If you’re sending the map to a cartographer (who may want to edit the map for publication),
it’s best to export as an SVG. SVG stands for “Scalable Vector Graphic”, and can be imported to programs like
Inkscape or other vector image editing software.

B

o £ Bxportas PDF. Tf you peed to send the map to a client, it’s most common to use a PDF, because it’s easier
to set up printing options for a PDF. Some cartographers may prefer PDF as well, if they have a program that
allows them to import and edit this format.

For our purposes, we’re going to use PDF.

1. Click the "}"IE Exportas PDF byyton

2. Choose a save location and a file name as usual. The following dialog will show up.
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PDF Export Options 0

lw| Export Options

Always export as vectors
v Append georeference information
v Export RDF metadata (title, author, etc.)

Text export | Always Export Text as Paths (Recommended) -

v Advanced Options

Disable tiled raster layer exports

v Simplify geometries to reduce output File size

@Help % cancel | Psave |

3. You can safely use the default values now and click Save.
QGIS will proceed to the map export and push a message on top of the print layout dialog as soon as it finishes.

4. Click the hyperlink in the message to open the folder in which the PDF has been saved in your system’s file
manager

5. Open it and see how your layout looks.
Everything is OK? Congratulations on your first completed QGIS map project!
6. Anything unsatisfying? Go back to the QGIS window, do the appropriate modifications and export again.

7. Remember to save your project file.
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4.1.7 In Conclusion

Now you know how to create a basic static map layout. We can go a step further and create a map layout that adapts
dynamically, with more layout items.

4.2 Lesson: Creating a Dynamic Print Layout

Now that you have learned to create a basic map layout we go a step further and create a map layout that adapts
dynamically to our map extent and to the page properties, e.g. when you change the size of the page. Also, the date
of creation will adapt dynamically.

4.2.1 Follow Along: Creating the dynamic map canvas

1. Load the ESRI Shapefile format datasets protected_areas.shp, places.shp, rivers.shp and
water . shp into the map canvas and adapt its properties to suit your own convenience.

2. After everything is rendered and symbolized to your liking, click the h New Print Layout joon in the Project

toolbar or choose Project » "2 New Print Layout. You will be prompted to choose a title for the new print
layout.

3. We want to create a map layout consisting of a header and a map of the region near Swellendam, South Africa.
The layout should have a margin of 7.5 mm and the header should be 36mm high.

4. Create a map item called main map on the canvas and go to the Layout panel. Scroll down to the Variables
section and find the Layout part. Here we set some variables you can use all over the dynamic print layout. Go
to the Layout panel and scroll down to the Variables section. The first variable will define the margin. Press the

Ifl'l:ll-:| button and type in the name sw_layout_margin. Set the value to 7.5. Press the Ifl'l:ll-:| button again
and type in the name sw_layout_height_header. Set the value to 36.

5. Now you are ready to create the position and the size of the map canvas automatically by means of the vari-
ables. Make sure that your map item is selected, go to the Item Properties panel, scroll down to and open

the Position and Size section. Click the &/ Datadefined override for ¥ and from the Variables entry, choose
@sw_layout_margin.

6. Click the 4£| Data defined override o,y choose Edit... and type in the formula:

[tofreal(@sw_layout_margin) + to_real (@sw_layout_height_header) ]

7. You can create the size of the map item by using the variables for Width and Height. Click the €
Data defined override for Width and choose Edit ... again. Fill in the formula:

[@layout_pagewidth — @sw_layout_margin * 2 }

Click the 46| Data defined override g, Height and choose Edit .... Here fill in the formula:

[@layout_pageheight — (@sw_layout_height_header - (@sw_layout_margin * 2 }

8. We will also create a grid containing the coordinates of the main canvas map extent. Go to Item Properties

again and choose the Grids section. Insert a grid by clicking the ':II-I:I-I:| button. Click on Modify grid ... and set
the Interval for X, Y and Offset according to the map scale you chose in the QGIS main canvas. The Grid type
Cross is very well suited for our purposes.
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4.2.2 Follow Along: Creating the dynamic header

1. Insert a rectangle which will contain the header with the "5 AddShape by tton. In the Jrems panel enter the name
header.

2. Again, go to the Item Properties and open the Position and Size section. Using €] Data defined override | hoose the
sw_layout_margin variable for X as well as for Y. Width shall be defined by the expression:

[@layout_pagewidth - @sw_layout_margin * 2 ]

and Height by the sw_layout_height_header variable.

3. We will insert a horizontal line and two vertical lines to divide the header into different sections using the IE
AddNode Item - Creqte a horizontal line and two vertical lines and name them Horizontal line,Vertical
line 1Vertical line 2.

1. For the horizontal line:
1. Set X to the variable sw_layout_margin

2. Set the expression for Y to:

[@sw_layout_margin + 8 J

3. Set the expression for Width to:

[@layout_pagewidth - (@sw_layout_margin * 3 - 53.5 ]

2. For the first vertical line:

1. Set the expression for X to:

[@layout_pagewidth - @sw_layout_margin * 2 - 53.5

2. Set Y to the variable sw_layout_margin

3. The height must be the same as the header we created, so set Height to the variable
sw_layout_height_header.

3. The second vertical line is placed to the left of the first one.

1. Set the expression for X to:

[@layout_pagewidth - @sw_layout_margin * 2 - 83.5 }

2. Set Y to the variable sw_layout_margin

3. The height shall be the same as the other vertical line, so set Height to the variable
sw_layout_height_header.

The figure below shows the structure of our dynamic layout. We will fill the areas created by the lines with
some elements.
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Layout Edit View Items AddIitem Atlas Settings

BROEDE B enabke e
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-+ + 340

é B \;‘f\ 2t e - + -
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1 item selected

4.2.3 Follow Along: Creating labels for the dynamic header

1. The title of your QGIS project can be included automatically. The title is set in the Project Properties.

111 | Items | Undo History
Items BE
@ - Item -
v ™ logo organisation
v v {7 vertical line 2
v v {7 vertical line 1
v map description
v == scale
v = north arrow
v [T] project title (Variable)
v [T] organisation information (Variables)
v v " horizontal line
o i 1 _hearder =3
Layout | Item Properties | Guides | Atlas
Item Properties [E]E]
< | Map Grid Properties
w Appearance =
Grid type Cross -
CRs EPSG:4326
Interval units Map unit -
X 0,050000000000 =
Interval
'Y 0,050000000000 a (s
X 0,050000000000 =
Offset
'Y 0,000000000000 B
Cross width 3,00 mm >
Line style M
» Blend mode Normal | -
x:124.577 mm y: 92.8866 mm page: 1 96.8% MLE
Insert

a label with the E!: AddLabel bytton and enter the name project title (variable). In the Main
Properties of the Items Properties Panel enter the expression:

[[%@project_title%]

Set the position of the label.

1. For X, use the expression:

[@sw_layout_margin + 3

2. For Y, use the expression:

[@sw_layout_margin + 0.25

3. For Width, use the expression:

[@layout _pagewidth - @sw_layout_margin *2 - 90

4. Enter 11.25 for Height

Under Appearance set the Font size to 16 pt.

2. The second label will include a description of the map you created. Again, insert a label and name it map
description. Inthe Main Properties enter the text map description. Inthe Main Properties we will

also include:

[printed on: [%format_date(now (), 'dd.MM.yyyy') %]

Here we used two Date and Time functions (now and format_date).

Set the position of the label.

1. For X, use the expression:
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[@sw_layout_margin + 3 J

2. For Y, use the expression:

[@sw_layout_margin + 11.5 J

3. The third label will include information about your organisation. First we will create some variables in the

Variables menu of the Item Properties. Go to the Layout menu, click the I:II-I:I-I:I button each time and enter the
names o_department, o_name, o_adress and o_postcode. Inthe second row enter the information
about your organisation. We will use these variables in the Main Properties section.

In Main Properties enter:

)

@Qo_name %]
@o_department %]
@o_adress %]
Qo_postcode %]

o° o o

o

[
[
[
[

Set the position of the label.

1. For X, use the expression:

[@1ayout_pagewidth - @sw_layout_margin - 49.5 ]

2. For Y, use the expression:

[@sw_layout_margin + 15,5 ]

3. For Width, use 49.00

4. For Height, use the expression:

{@sw_layout_height_header = 15,5 ]
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Layout @ Item Properties = Guides = Atlas

Item Properties (3]
Label

¥ Main Properties

[% @o_name%]

[% @0 department]
[% @o_adress%]

Pﬁ @o_postcode%|

Render as HTML

Insert an EKPFEESiGI"I...

4.2.4 Follow Along: Adding pictures to the dynamic header

1. Use the "3 AddPicwre byiton to place a picture above your label organisation information. After
entering the name organisation logo define the position and size of the logo:

1. For X, use the expression:

[@layout_pagewidth — @sw_layout_margin - 49.5 ]

2. For Y, use the expression:

{@sw_layout_margin + 3.5 ]

3. For Width, use 39.292
4. For Height, use 9.583
To include a logo of your organisation you have to save your logo under your home directory and enter the path
under Main Properties » Image Source.
2. Our layout still needs a north arrow. This will also be inserted by using A] Add North Arrow  WWe will use the
default north arrow. Define the position:

1. For X, use the expression:

[@layout_pagewidth - @sw_layout_margin * 2 - 78 ]

2. For Y, use the expression:

[@ sw_layout_margin + 9
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3. For Width,use 21 .027
4. For Height,use 21 .157

4.2.5 Follow Along: Creating the scalebar of the dynamic header

1. To insert a scalebar in the header click on Add Seale Bar and place it in the rectangle above the north arrow.

In Map under the Main Properties choose your main map (Map 1). This means that the scale changes
automatically according to the extent you choose in the QGIS main canvas. Choose the Style Numeric. This
means that we insert a simple scale without a scalebar. The scale still needs a position and size.

1. For X, use the expression:

[@1ayout_pagewidth - @sw_layout_margin * 2 - 78

2. For Y, use the expression:

[@sw_layout_margin + 1

3. For Width, use 25
4. For Height, use 8
5. Place the Reference point in the center.

Congratulations! You have created your first dynamic map layout. Take a look at the layout and check if everything
looks the way you want it! The dynamic map layout reacts automatically when you change the page properties. For

| .
example, if you change the page size from DIN A4 to DIN A3, click the M Refreshview bytton and the page design is
adapted.

Layout Edit View Items AddIitem Atlas Settings

=) N =) |
B GRQRDE L eRikikhe i B
~ul h @& O O [
PLPLAT @ E LR btEl
™ B B R B e R R0 0 B | ikems | undo History
E Items BE
: = ® ] Item E
v v { vertical line 1
The area of Swellendam 1:116495 ’ v o mep description
== scale
map description v v = north arrow
“Your department’ v v [T] project title (Variable)
"Your organisation’ . . . N .
( \ “Vour adress v v [T] organisation information (Variables)
Prinéed on: 16052013 &) “Your posicods’ v v { horizontal line
v v [ header
204 204 20.5 205 206 206 1N main map (Map 0)
339 + + + + + + 339 Layout | Item Properties | Guides = Atlas
Item Properties [=]E]
< | Map Grid Properties
w Appearance =
-33.9 + + + + + + -33.9 Grid type Cross -
CRs EPSG:4326
Interval units Map unit -
X 0,050000000000 =
-+ 4+ 340 Interval
1 'Y 0,050000000000 a (s
- X 0,050000000000 =
E Offset
? 'Y 0,000000000000 =
= + + -34.0 Cross width 3,00 mm it
L= Line style M
22 -
e ! ° » Blend mode Normal ~| |+
1 item selected x:124.577 mm y: 63.6546 mm page: 1 96.8% v |-k
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4.2.6 What’s Next?

On the next page, you will be given an assignment to complete. This will allow you to practice the techniques you
have learned so far.

4.3 Assignment 1

Open your existing map project and revise it thoroughly. If you have noticed small errors or things you’d have liked
to fix earlier, do so now.

While customizing your map, keep asking yourself questions. Is this map easy to read and understand for someone
who’s unfamiliar with the data? If I saw this map on the Internet, or on a poster, or in a magazine, would it capture
my attention? Would I want to read this map if it wasn’t mine?

If you’re doing this course at a %+ Basic or %% Intermediate level, read up on techniques from the more advanced
sections. If you see something you’d like to do in your map, why not try to implement it?

If this course is being presented to you, the course presenter may require you to submit a final version of your map,
exported to PDF, for evaluation. If you're doing this course by yourself, it’s recommended that you evaluate your own
map using the same criteria. Your map will be evaluated on the overall appearance and symbology of the map itself,
as well as the appearance and layout of the map page and elements. Remember that the emphasis for evaluating the
appearance of maps will always be ease of use. The nicer the map is to look at and the easier it is to understand at a
glance, the better.

Happy customizing!

4.3.1 In Conclusion

The first four modules have taught you how to create and style a vector map. In the next four modules, you’ll learn
how to use QGIS for a complete GIS analysis. This will include creating and editing vector data; analyzing vector
data; using and analyzing raster data; and using GIS to solve a problem from start to finish, using both raster and
vector data sources.
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FIVE

MODULE: CREATING VECTOR DATA

Creating maps using existing data is just the beginning. In this module, you’ll learn how to modify existing vector
data and create new datasets entirely.

5.1 Lesson: Creating a New Vector Dataset

The data that you use has to come from somewhere. For most common applications, the data exists already; but the
more particular and specialized the project, the less likely it is that the data will already be available. In such cases,
you'll need to create your own new data.

The goal for this lesson: To create a new vector dataset.

5.1.1 Follow Along: The Layer Creation Dialog

Before you can add new vector data, you need a vector dataset to add it to. In our case, you'll begin by creating new
data entirely, rather than editing an existing dataset. Therefore, you’ll need to define your own new dataset first.

1. Open QGIS and create a new blank project.

2. Navigate to and click on the menu entry Layer » Create Layer » New Shapefile Layer. You'll be presented
with the New Shapefile Layer dialog, which will allow you to define a new layer.
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.
File name
File encoding UTF-8 >
Geometry type Point v
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WG5S B4 v ||

New Field

Name

Type | abc Text data v

Length |80 Precision

Add to Fields List

Fields List

MName Type Length Precision

id Integer 10

Remowve Field

OK Cancel Help

Click ... for the File name field. A save dialog will appear.
Navigate to the exercise_data directory.
Save your new layer as school_property.shp.

It’s important to decide which kind of dataset you want at this stage. Each different vector layer type is “built
differently” in the background, so once you’ve created the layer, you can’t change its type.

For the next exercise, we're going to create new features which describe areas. For such features, you'll need
to create a polygon dataset.

For Geometry Type, select Polygon from the drop down menu:

Geometry type ~ Polygon -

This has no impact on the rest of the dialog, but it will cause the correct type of geometry to be used when the
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vector dataset is created.

The next field allows you to specify the Coordinate Reference System, or CRS. CRS is a method of associating
numerical coordinates with a position on the surface of the Earth. See the User Manual on Working with
Projections to learn more.

For this example we will use the default CRS associated with this project, which is WGS84.

EP5G:4326 - WG5S 84 - ||

Next there is a collection of fields grouped under New Field. By default, a new layer has only one attribute, the
id field (which you should see in the Fields list) below. However, in order for the data you create to be useful,
you actually need to say something about the features you’ll be creating in this new layer. For our current
purposes, it will be enough to add one field called name that will hold Text data and will be limited to text
length of 80 characters.

7. Replicate the setup below, then click the Add to Fields List button:

New Field

MName |name
Type |ab<Text data -
Length 80 Precision

Add to Fields List

8. Check that your dialog now looks like this:
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G
File name aining-Data-2.0\exercise_data\school_property.shp
File encoding UTF-8 >
Geometry type ~ Polygon -
Additional dimensions ‘@' None Z (+ M values) M values
EPSG:4326 - WGS 84 v ||
New Field
Name
Type | abc Text data v
Length |80 Precision
Add to Fields List
Fields List
MName Type Length Precision
id Integer 10
name String a0
Remove Feld
OK Cancel Help
9. Click OK

The new layer should appear in your Layers panel.

5.1.2 Follow Along: Data Sources

When you create new data, it obviously has to be about objects that really exist on the ground. Therefore, you'll need
to get your information from somewhere.

There are many different ways to obtain data about objects. For example, you could use a GPS to capture points in
the real world, then import the data into QGIS afterwards. Or you could survey points using a theodolite, and enter
the coordinates manually to create new features. Or you could use the digitizing process to trace objects from remote
sensing data, such as satellite imagery or aerial photography.

For our example, you’ll be using the digitizing approach. Sample raster datasets are provided, so you’ll need to import
them as necessary.
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1. Click on "B D Sorc Manage b0

. Select :'- Raster on the left side.

. In the Source panel, click on the ... button:

2

3

4. Navigate to exercise_data/raster/.

5. Select the file 3420C_2010_327_RGB_LATLNG.tif.
6

. Click Open to close the dialogue window.

Q Data Source Manager | Raster #
i Browser Source type

+ Vector i .
'@ Fle () Protocol: HTTP(S), cloud, etc.

_';!:_ Mesh =lliiz

. Delimited Text Raster Dataset(s) ercise_data\raster\3420C_2010_327_RGB_LATLNG.tf & | ... |

GeoPackage

patiaLite

. Oracle
082, DB2

m Virtual Layer

&2 wms/wmTs
£ wes

- f‘_ WFS

ArcGIS Map Server
- ArcGIS Feature Server

* GeoMNode

| Cose || add || Hep |

7. Click Add and Close. An image will load into your map.
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@ *Untitled Project - QGIS - [} X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEEREX Lo PPRABLNR @6 -5 55 83 =90
®R@V.awm @ o - =y @ : ® 2

Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.5018,34.0192 |% Scale 1:27241 |~ | @ Mognifier 100%  |*| Rotation [0.0° %/ [v/Render @ EPsGia3zs @

8. If you don’t see an aerial image appear, select the new layer, right click, and choose Zoom fo Layer in the
context menu.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Raster Datab:

DEBRRY QPRI PR
B@V.Aam @ /7 :

Layers &
v [l ® T - O

3420C ?2n1n 227 par 1LATING |
sl '® Zoom to Layer

o2 Show in Overview

Copy Layer
Rename Layer
1 Zoom to Native Resolution (100%)
Stretch Using Current Extent
L] Duplicate Layer
[l Remove Layer...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

9. Click on the ﬁ-) ZoomIn bytton, and zoom to the area highlighted in blue below:
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(@ *Untitled Project - QGIS - O x
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBRRX OBFLPAIPRPALEENR &6 -5 -5-5 Im-9 -
R@V- AR B ) b Sl R 2

Layers (E2]E3)
o @ ® T O -0
v ¥ 3420C 2010 327 RGB LATLNG
v! [ school_property

[ & Typetolocate (cul+k) | Ready Coordinate| 20.4529,-34.0291 |¥ Scale 1:27241 |~ @ Magnifier 100%  |%| Rotation [0.0° *|v/Render @ epsGi36 @

Now you are ready to digitize these three fields:
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Before starting to digitize, let’s move the school_property layer above the aerial image.

1. Select school_property layer in the Layers pane and drag it to the top.

Layers e
o [l ® T &§~3 F 4

v [ school property
v 2 3420C 2010 327 RGB LATLNG

In order to begin digitizing, you'll need to enter edit mode. GIS software commonly requires this to prevent you
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from accidentally editing or deleting important data. Edit mode is switched on or off individually for each layer.
To enter edit mode for the school_property layer:

1. Click on the school_property layer in the Layers panel to select it.

F/ .
2. Click on the .’/ Toggle Editing [ytton.

If you can’t find this button, check that the Digitizing toolbar is enabled. There should be a check mark next to
the View » Toolbars » Digitizing menu entry.

As soon as you are in edit mode, you'll see that some digitizing tools have become active:

. £ Capture Polygon

o / % Vertex Tool

Other relevant buttons are still inactive, but will become active when we start interacting with our new data.

Notice that the layer school_property in the Layers panel now has the pencil icon, indicating that it is in
edit mode.

e )
3. Click on the L3 Capwre Polyzon bytton to begin digitizing our school fields.

You'll notice that your mouse cursor has become a crosshair. This allows you to more accurately place the
points you’ll be digitizing. Remember that even when you're using the digitizing tool, you can zoom in and
out on your map by rolling the mouse wheel, and you can pan around by holding down the mouse wheel and
dragging around in the map.

The first feature you’ll be digitizing is the athletics field:

4. Start digitizing by clicking on a point somewhere along the edge of the field.

5. Place more points by clicking further along the edge, until the shape you're drawing completely covers the field.
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@ +Untitled Project - QGIS — O b4
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DEBREY 0 ALHAPD "Q  LEORS &&-NN-8-F;HE -~
BR@V:Z2Rm @ 4/ 8BR - b =g mE R A

Layers e
@l e T &-#H0

v! [ school property
v/ I 3420C_2010_327_RGB_LATLNG

| Q Type to locate (Ctri+K) | i 20.444140,-34.024140 | ¢[1:1308 <| @rfwowe |33 00° |2 VIRender @ epsGiaszs @

6. After placing your last point, right click to finish drawing the polygon. This will finalize the feature and show
you the Attributes dialog.

7. Fill in the values as below:

school_property - Feature Attributes

d 1 a |
name | Athletics Field a |
OK || Cancel |
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8. Click OK, and you have created a new feature!

Q@ *Untitled Project - QGIS - O X

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

EERRY 0APLPNPP R RBLNR @& -N-8-%8E -
RQV.Am B 2/B%x- 6o mqRqE - @ A

Layers
o e Ta-BAO

v [# school property
v! ¥ 3420C_2010_327_RGB_LATLNG

| Q. Type to locate (Ctri+K) | i) 20.447232,-34.023345 | ¥ ¢ 1:1308 v @rlwoe 3]s looe  [f| VIRender @ epsci43s @

9. In the Layers panel select the school_property layer.

10. Right click and choose Open Attribute Table in the context menu.
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() *Untitled Project - QGIS

Project Edit View Layer Settings Plugins Vector Ras

NEERREY U 2K
RSV Z @B 47

Layers |
o [ ® T &§~6F & 4 '
7 school prisa l

v % 3420C 2( + Zoom to Layer

Zoom to Selection
“2 Show in Overview
Show Feature Count
Copy Layer
Rename Layer
L Duplicate Layer
[4 Remove Layer...
8 Open Attribute Table
|;.i" |TDggIe Editing
; Current Edits
Filter...
Change Data Source...
Set Layer Scale Visibility...
Set CRS
Export
Styles

Properties...

In the table you will see the feature you just added. While in edit mode you can update the attributes data by
double click on the cell you want to update.
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id name
1 1| Athletics Field

T show Al Features _

g LT ES D BE P E »

* || Update All || Update Selected

11. Close the attribute table.

12. To save the new feature we just created, click on n' Save Edits ¢t

Remember, if you've made a mistake while digitizing a feature, you can always edit it after you’re done creating it.
If you’ve made a mistake, continue digitizing until you're done creating the feature as above. Then:

1. Click on /E;{ Vertex Tool ¢,

2. Hover the mouse over a vertex you want to move and left click on the vertex.

3. Move the mouse to the correct location of the vertex, and left click. This will move the vertex to the new

location.
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The same procedure can be used to move a line segment, but you will need to hover over the midpoint of the
line segment.

If you want to undo a change, you can press the b Undo bytton or Ctr1+2.
4. Remember to save your changes by clicking the -4 Save Edits hyton,

5. When done editing, click the y Toggle Editing ytton to get out of edit mode.
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5.1.3 Try Yourself: Digitizing Polygons

Digitize the school itself and the upper field. Use this image to assist you:

Remember that each new feature needs to have a unique id value!

Note: When you're done adding features to a layer, remember to save your edits and then exit edit mode.

Note: You can style the fill, outline and label placement and formatting of the school_property using tech-
niques learnt in earlier lessons.
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5.1.4 Follow Along: Using Vertex Editor Table

Another way to edit a feature is to manually enter the actual coordinate values for each vertex using the Vertex Editor
table.

1. Make sure you are in edit mode on layer school_property.

2. If not already activated, click on /ﬂ;‘ Vertex Tool y¢ton,

3. Move the mouse over one of the polygon features you created in the school property layer and right
click on it. This will select the feature and a Vertex Editor pane will appear.

Vertex Editor (E]ES)
X v r

0l 20.4456 -34,0226 |
o e —
2 20.4457 -34,0251

3 20.4453 -34,0247

4/20.4450 -34,0250

5| 204441 -34.0241

6 20.4456 -34,0226

Note: This table contains the coordinates for the vertices of the feature. Notice there are seven vertices for
this feature, but only six are visually identified in the map area. Upon closer inspection, one will notice that
row 0 and 6 have identical coordinates. These are the start and end vertices of the feature geometry, and are
required in order to create a closed polygon feature.

4. Click and drag a box over a vertex, or multiple vertices, of the selected feature.
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)

The selected vertices will change to a color blue and the Vertex Editor table will have the corresponding rows
highlighted, which contain the coordinates of the vertices.
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Q@ “basic_map - QGIS - O X
Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Help

DB mRR @@w@a@ﬂa PP, EBLO
LLAYA NS AN % & < = B - @

Browser (=]
QaTHO
<+ Favorites =

» IV Spatial Bookmarks
’ Project Home
+ [a] Home
v OC\
+ @ GeoPackace
Layers (=]
o @l®To-#FTDL

roads

[#] school_property

¥ 3420C 2010 327 RGB LATLNG

[

Vertex Editor 3]
X ' r

0 20.4456 34,0226

1 20.4469 -34.0238

2 20,4457 -34.0251

-34.0247

-34.0250

-34.0241

| Q. Type tolocate (Ctri+K) | Validi rdi| 20.447353,-34.025117 |9 ¢|1:1521

5. To update a coordinate, double left click on the cell in the table that you want to edit and enter the updated
value. In this example, the x coordinate of row 4 is updated from 20.4450t0 20.4444.
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Vertex Editor ®
X v r
0| 20.4456 -34.0226
1) 20,4469 -34.0238
2| 20.4457 -34,0251
3/ 20.4453 -34.0247
e |
5 20,444 -34.0241
6| 20.4456 -34.0226
Q Type to locate (Ctri+K) Validi rdii| 20.4441

6. After entering the updated value, hit the enter key to apply the change. You will see the vertex move to the
new location in the map window.

7. When done editing, click the f Toggle Editing tyytton to get out of edit mode, and save your edits.

5.1.5 Try Yourself: Digitizing Lines

We are going to digitize two routes which are not already marked on the roads layer; one is a path, the other is a track.
Our path runs along the southern edge of the suburb of Railton, starting and ending at marked roads:
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Our track is a little further to the south:
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. Since you are working with a line feature, click on the

. If the roads layer is not yet in your map, then add the roads layer from the GeoPackage file
training-data.gpkg included in the exercise_data folder of the training data you downloaded.
You can read 77 Follow Along: Loading vector data from a GeoPackage Database for a how-to.

. Create a new ESRI Shapefile line dataset called routes. shp in the exercise_data directory, with

attributes 1d and type (use the approach above to guide you.)

. Activate edit mode on the routes layer.

Va

Add Line byytton to initiate line digitizing mode.

. One at a time, digitize the path and the track on the routes layer. Try to follow the routes as accurately as

possible, adding additional points along corners or turns.

. Set the type attribute value to path or track.

. Use the Layer Properties dialog to add styling to your routes. Feel free to use different styles for paths and

tracks.

4 -
. Save your edits and toggle off editing mode by pressing the f/ Toggle Editing 1y, tton,
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Answer

The symbology doesn’t matter, but the results should look more or less like this:

00606 QGIS 2.0.1-Dufour - basic_map.

DOBRBLORANBPLALLAPLLALR & & K EBE =0 52 [ BR
V.0 8B % B& 5= =) H g =
4
R\, & e
@ » ™ school_property
[ [" 3420C_2010_327_RGB_LATLNG
el ™ landuse
%
%
Vi
0d
g Bontabok Nationg] Park Reception & Shop
Loyors
Toggles the editing state of the current layer There is a new plugin available @] Coordinate: | 20.44958,34.04065 | Scale (19566 + [/] @ Render EPSG:4326 (G y

5.1.6 In Conclusion

Now you know how to create features! This course doesn’t cover adding point features, because that’s not really
necessary once you’ve worked with more complicated features (lines and polygons). It works exactly the same, except
that you only click once where you want the point to be, give it attributes as usual, and then the feature is created.

Knowing how to digitize is important because it’s a very common activity in GIS programs.
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5.1.7 What’s Next?

Features in a GIS layer aren’t just pictures, but objects in space. For example, adjacent polygons know where they
are in relation to one another. This is called topology. In the next lesson you'll see an example of why this can be
useful.

5.2 Lesson: Feature Topology

Topology is a useful aspect of vector data layers, because it minimizes errors such as overlap or gaps.

For example: if two features share a border, and you edit the border using topology, then you won’t need to edit first
one feature, then another, and carefully line up the borders so that they match. Instead, you can edit their shared
border and both features will change at the same time.

The goal for this lesson: To understand topology using examples.

5.2.1 Follow Along: Snapping

Snapping makes topological editing easier. This will allow your mouse cursor to snap to other objects while you
digitize. To set snapping options:

1. Navigate to the menu entry Project » Snapping Options....

2. Set up your Snapping options: enable snapping using the @ Enable Snapping byitton, choose the Advanced Con-
figuration, activate the 1anduse layer with Type vertex and tolerance 12 pixels:

Project Snapping Settings ca

« | ‘& Advanced Configuration_ | © Topological Editing Snapping on Intersection

Layer Type Tolerance Units Avoid overlap
® places
| buildings
— roads
I water
rivers
v landuse vertex 12 pixels v
[Tl protected_areas

Q, Filter layers...

3. Make sure that the box in the Avoid overlap column is checked.

4. Leave the dialog.

5. Select the landuse layer and enter edit mode ( .# )
6. Check (under View » Toolbars) that the Advanced Digitizing toolbar is enabled.

7. Zoom to this area (enable layers and labels if necessary):
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*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERRY OAPLHPRFALEEDR

LAVAEL S S RE RERFE G- QR B-G PR K-
6e-M-8-LbEEH#IZ=m-7 LB BIRRRARPS HRP > R
Layers @@
@ vanva-arn
v| ® places =
! [ buildings
v| — roads
v| [ water
v rivers
| M Bl landuse |
Browser @®
LET®O

» ¢ Favorites
» " spatial Bookmarks
» [¥ Project Home

» [&] Home

» [0/
»
»
13

-

4

@ GeoPackage
# spatiaLite
@ Postals

4

SEDHAABANLEMS

i
a
o
B

&

@ WMS/WMTS
@ XYZ Tiles
& wes

7 WFS / OGC API - Features
) ows

@ ArcGismapServer

& ArcGisFeatureServer

¢ GeoNode

v vy wvow

| @ Type to locate (Ctrl+k) Coordinate| 20.48982-34.00907 |9 Scale|1:14392 = | @ Magnifier 100% | Rotation |0,0° %[V Render 4 gPsGi4326 @

8. Digitize this new (fictional) area shown in red:

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEBRmE OA2ARLHAPPR A L LR

LAVAIELL T “QRE RPERRYG -Q-R-B-G- |
6e-M-8-LEE#IZ=- 7 LB BOIRRRARPS HRP
Layers @6
o @ ® T &~ AL
v/ e places =
! [ buildings
v| — roads
v| [ water
v rivers
| M Bl landuse |
< v
Browser @®
Lerv®e

» ¢ Favorites
» " spatial Bookmarks
» [*¥ Project Home

» [&] Home

» O/
»
»
»

-

@ GeoPackage — landuse - Feature Attributes

# spatiaLite

T Actions
@ Postclis -

SEHSSBABNS

4
v
=
0
]
Q
=

ogc_fid [999{ a I v
Full_id |NULL |

i
a
o
B

&

@ WMS/WMTS

@ XYZ Tiles

& wes

&7 WFS / OGC API - Features
) ows

@ ArcGismapServer

Si‘t' ArcGisFeatureServer

# GeoNode

osm_id |NULL

v v e ww

Q Type to locate (Ctrl+K) Coordinate| 20.4923134.00731 |9 Scale[114392 |~ | @ Magnifier 100% | Rotation |0.0° % |V Render @ EPSCa32e @

9. When prompted, give it an OGC_FID of 999, but feel free to leave the other values unchanged.
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If you are careful while digitizing, and allow the cursor to snap to the vertices of adjoining areas, you’ll notice
that there won’t be any gaps between your new area and the existing adjacent areas.

10. Note the @ undo apd @ redo tools in the Advanced Digitizing toolbar.

5.2.2 Follow Along: Correct Topological Features

Topology features can sometimes need to be updated. In our study area, an area has been turned into forest, so the
landuse layer need an update. We will therefore expand and join some forest features in this area:

*example - QGIS B

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help

DEERRY OAPLHPRFALEEDR

AT N S NI REBRRR G- R B G BRSX K-
0@ -2 LEE$I=G0 LB BOIRTANCS HFRE” - - @
Layers @@
« @ ® T & AL
v| ® places =
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v| — roads
'ﬂ v| [ water
v rivers
Eg M P landuse 153
e ¢ »
}fu Browser @®
- LRATRO
Y
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'uv » [[* spatial Bookmarks
» [® Project Home

@' b [¢] Home
€ el
= » @ GeoPackage
@v » /# spatiaLite
+ @ postGls
V;' P MssQL
= @ pB2
K@ @ WMS/WMTS
» @ XYZ Tiles
» @& wes
» @ WFS / OGC API - Features
» O ows

@ ArcGismapServer
& ArcGisFeatureServer
¢ GeoNode

N

Q Type to locate (Ctrl+K) Coordinate| 20.48982,34.00907 % Scale|1:14392 ~ | @ Magnifier| 100%

~| Rotation |0,0° | |v/ Render # EPsG4326 @

Instead of creating new polygons to join the forest areas, we are going to use the Vertex Tool to edit and join existing
polygons.

1. Enter edit mode (if it is not active already)

2. Select the /BE( Vertex Tool 4]

3. Choose an area of forest, select a vertex, and move it to an adjoining vertex so that the two forest features meet:
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*example - QGIS

Project Edit View Layer Settings Plugins Vector Raster Database Web Mesh Processing Help
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; i /i /
| @ Type to locate (Ctrl+k) | Coordinate| 20.51955-34.01389 |9 Scale 1:6588 ~| & magnifier| 100% | Rotation |0,0° %[V Render 4 gPsGi4326 @

4. Click on the other vertices and snap them into place.

The topologically correct border looks like this:

*example - QGIS
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Go ahead and join a few more areas using the Vertex Tool.

G
You can also use the LI AddPolygon Feature 6] (o £i]] the gap between the two forest polygons. If you have
enabled Avoid overlap, you don’t have to add every single vertex - they will be added automatically if your new
polygon overlaps the existing ones.

If you are using our example data, you should have a forest area looking something like this:

*example - QGIS B
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Don’t worry if you have joined more, less or different areas of forest.

5.2.3 Follow Along: Tool: Simplify Feature

Continuing on the same layer, we will test the %) Simplify Feature ¢6,]:
1. Click on it to activate it.

2. Click on one of the areas which you joined using either the Vertex Tool or Add Feature tool. You will see this
dialog:
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|J¢§ancel|l «/ OK ]

- |

Method | simplify by distance

:] Layer units

Tolerance ’ oloooo00
1 feature(s): 17 to 17 vertices (100%)

3. Modify the Tolerance and watch what happens:

|X§ancel|[ «/ OK ]

- |

Method | Simplify by distance

A
“ | Tolerance ’

1 feature(s): 17 to 5 vertices (29%)

|:] | Layer units

This allows you to reduce the number of vertices.

4. Click OK
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The advantage of this tool is that it provides you with a simple and intuitive interface for generalization. But notice
that the tool ruins topology. The simplified polygon no longer shares boundaries with its adjacent polygons, as it
should. So this tool is better suited for stand-alone features.

Before you go on, set the polygon back to its original state by undoing the last change.

5.2.4

Try Yourself: Tool: Add Ring

The AddRing t0] allows you to add an interior ring to a polygon feature (cut a hole in the polygon), as long as the
hole is completely contained within the polygon (touching the boundary is OK). For example, if you have digitized
the outer boundaries of South Africa and you need to add a hole for Lesotho, you would use this tool.

If you experiment with the tool, you may notice that the snapping options can prevent you from creating a ring inside

a polygon. So you are advised to turn off snapping before cutting a hole.

1. Disable snapping for the 1anduse layer using the @ Enable Snapping by tton (or use the shortcut s).

2. Use the AddRing 0] to create a hole in the middle of a polygon geometry.

(o)
3. Draw a polygon over the target feature, as if you were using the Add polygon (0],

4. When you right-click, the hole will be visible.
(@)

5. Remove the hole you just created using the £ Pelete Ring o0] - Click inside the hole to delete it.

Answer

The exact shape doesn’t matter, but you should be getting a hole in the middle of your feature, like this one:
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¢ Undo your edit before continuing with the exercise for the next tool.
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5.2.5 Try Yourself: Tool: Add Part

The gDJ AddPart ¢60] allows you to add a new part to a feature, that is not directly connected to the main feature. For
example, if you have digitized the boundaries of mainland South Africa, but you haven’t yet added the Prince Edward
Islands, you would use this tool to create them.

1. Select the polygon to which you wish to add the part by using the Eﬁ Select Features by area or single click 0]

2. Use the Add Part tool to add an outlying area.

3. Delete the part you just created using the ggl Delete Part 0],

Note: Click inside the part to delete it.

Answer

1. First select the Bontebok National Park:
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2. Now add your new part:
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0606 QGIS 2.0.1-Dufour - basic_map.
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Validation finished.

lugin available [Q§] Coordinate: 20.47200,34.05102 Scale [1:7028 ~) [&/] @ Render EPSG:4326 (@] y

3. Undo your edit before continuing with the exercise for the next tool.

5.2.6 Follow Along: Tool: Reshape Features

The ? Reshape Features 10] j5 used to extend a polygon feature or cut away a part of it (along the boundary).

Extending:

1. Select the polygon using the E?; Select Features by area or single click ]

2. Left-click inside the polygon to start drawing.

3. Draw a shape outside the polygon. The last vertex should be back inside the polygon.
4. Right-click to finish the shape:
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This will give a result similar to:
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Cut away a part:

1
1. Select the pOlngIl using the % Select Features by area or single click tool.
2. Click outside the polygon.

3. Draw a shape inside the polygon. The last vertex must be back outside the polygon.
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4. Right-click outside the polygon:
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The result of the above:
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5.2.7 Try Yourself: Tool: Split Features

Q'DSI'tFt e i (PRh Features : :
The ¢® SPHEEANIES to0] is similar to the eshape Features ool, except that it does not delete either of the two parts.

Instead, it keeps them both.
We will use the tool to split a corner from a polygon.

1. First, select the 1anduse layer and re-enable snapping for it.

ado .
2. Select the ¢® SPlitFeawres ¢60] and click on a vertex to begin drawing a line.

3. Draw the bounding line.

4. Click a vertex on the “opposite” side of the polygon you wish to split and right-click to complete the line:
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5. At this point, it may seem as if nothing has happened. But remember that the 1anduse layer is rendered

without border lines, so the new division line will not be shown.

6. Use the ;::[!«-?: Select Features by area or single click ] 1o select the part you just split out; the new feature will now be

highlighted:
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5.2.8 Try Yourself: Tool: Merge Features

Now we will re-join the feature you just split out to the remaining part of the polygon:

==
1. Experiment with the @Merge Selected Features and % Merge Attributes of Selected Features tools.

2. Note the differences.

Answer

* Use the Merge Selected Features tool, making sure to first select both of the polygons you wish to merge.

* Use the feature with the OGC_FID of 1 as the source of your attributes (click on its entry in the dialog, then

click the Take attributes from selected feature button):

If you're using a different dataset, it is highly likely that your original polygon’s OGC_FID will not be 1. Just choose

the feature which has an OGC_FID.

5.2. Lesson: Feature Topology

167



QGIS Training Manual

8086 Merge feature attributes
OGC_FID | GEOMETRY | osm_id | osm_way_id | name | type | aeroway amenity | adminjeve | barrier |
Id Skip attribute _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Feature 1 _H Feature 1 _:T Feature 1 _:I Fei
|1 H1 HNULL Hzasﬁag? ” NULL ”Bomebok National Park Hboundary ”NULL HNULL HNULL ”NULL ‘@
14 NULL 2855697 NULL Bontebok National Park boundary NULL NULL NULL NULL atior
Morge  Skipped 2855607 Bontebok National Park boundary natic

| ] | Take atiributes from selected feature

| & | Remove feature from selection

| Cancel | OK

Using the Merge Attributes of Selected Features tool will keep the geometries distinct, but give them the same attributes.

5.2.9 In Conclusion

Topology editing is a powerful tool that allows you to create and modify objects quickly and easily, while ensuring
that they remain topologically correct.

5.2.10 What’s Next?

Now you know how to digitize the shape of the objects easily, but adding attributes is still a bit of a headache! Next
we will show you how to use forms, making attribute editing simpler and more effective.

5.3 Lesson: Forms

When you add new data via digitizing, you're presented with a dialog that lets you fill in the attributes for that feature.
However, this dialog is not, by default, very nice to look at. This can cause a usability problem, especially if you
have large datasets to create, or if you want other people to help you digitize and they find the default forms to be
confusing.

Fortunately, QGIS lets you create your own custom dialogs for a layer. This lesson shows you how.

The goal for this lesson: To create a form for a layer.
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5.3.1 Follow Along: Using QGIS’ Form Design Functionality

1. Select the roads layer in the Layers panel

2. Enter Edit Mode as before

3. Open the roads layer’s attribute table

4. Right-click on any cell in the table. A short menu will appear, that includes the Open form entry.
5. Click on it to see the form that QGIS generates for this layer

Obviously it would be nice to be able to do this while looking at the map, rather than needing to search for a specific
street in the Attribute Table all the time.

1. Select the roads layer in the Layers panel

p
2. Using the QR Identify Features 0] click on any street in the map.

3. The Identify Results panel opens and shows a tree view of the fields values and other general information about
the clicked feature.

4. At the top of the panel, check the Auto open form for single feature results checkbox in the “ Identify Settings

menu.

5. Now, click again on any street in the map. Along the previous Identify Results dialog, you'll see the now-familiar
form:

0086 Attributes - roads

osm_id  |47587910) a

name NULL

highway unclassified &

waterway |NULL

aerialway | NULL

barrier NULL

man_made NULL

other_tags | 'lanes'=="2" @

[ ol | [0K]

6. Each time you click on a single feature with the Identify tool, its form pops up as long as the Auto open form is
checked.
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5.3.2 Try Yourself: Using the Form to Edit Values

If you are in edit mode, you can use this form to edit a feature’s attributes.

1. Activate edit mode (if it isn’t already activated).

2. Using the Q% Identify Features 0], click on the main street running through Swellendam:

| 238808188

name [Voortrei Street |

highway |tar|iary ‘

waterway | NULL ‘

aerialway  [NULL |

barrier [nuLe |

man_made |NULL |

other_tags |"Ianm"=>"2“

3. Edit its highway value to be secondary

4. Exit edit mode and save your edits

5. Open the Attribute Table and note that the value has been updated in the attributes table and therefore in the
source data

5.3.3 Follow Along: Setting Form Field Types
It’s nice to edit things using a form, but you still have to enter everything by hand. Fortunately, forms have different
kinds of so-called widgets that allow you to edit data in various different ways.

1. Open the roads layer’s Properties...

2. Switch to the Fields tab. You'll see this:
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Layer Properties - roads | Fields

|/ | &)
,’i e Tem id -~ Name Alias Type Typename Length Precision Comment WMS WFS *
s 122 0 [fid glonglong Integer64 0 0 v v
W Source . . :
: abe 1 Full_id Qstring  String 255 0 v v
-
& Symbology ac 2 | osm_id Qstring  String 255 0 v v
a3 Labels abc 3 osm_type QString  String 255 0 v v
ac 5 lanes Strin strin 0 v v
d Diagrams Q < =
-~ ac §  maxspeed Qstring  String 255 0 v v
hy 3D View . .
abc 7 oneway Qstring  String 255 0 v v
[ 5 Fields ae 8 | ref QString  String 255 0 v v
Attributes . .
B abc 9 surface Qstring  String 255 0 v v
Joins abc 10 name Qstring  string 255 0 v v
_’l Augxiliary abc 11 embankment Qstring  String 255 0 v v
Storage . . .
@ abc 12 maxweight Qstring  String 255 0 v v -
AF} Actions
.| @Help || shyle - | JApply || X cancel || oK |
3. Switch to the Attributes Form tab. You'll see this:
Layer Properties - roads | Attributes Form
|Autogenerate - \ |E\ |Show form on add Feature (global settings) ~ |
) Information “ | Available widgets =
Fields
23 source fid
- Full_id
=" symbol osm_id
o Abehy osm_type
€= Labels highway
lanes
maxspeed
€D Masks oneway
- , ref
, Diagrams surface
name
W 3D View embankment
maxweight
E Fields destination:back...
destination:Fforward
Attributes Form destination:ref:ba...
destination:symb...
Joins cutting
access
ﬂ Augxiliary hgv
Storage Foot -
——— |
B oacions T “Jnopl | Xcancel [ doK_]

4. Click on the oneway row and choose Checkbox as Widget Type in the list of options:

5.3. Lesson: Forms 171



QGIS Training Manual

Layer Properties - roads | Attributes Form X

Autogenerate

“ Available widgets =
~ Fields
fid
full_id
osm_id
osm_type
highway
lanes

-||A

v General

Alias

Comment

v| Editable Label on top

Show form on add feature (global settings) ~

-

maxsEeed

ref

surface

name

embankment
maxweight
destination:backw...
destination:forward
destination:ref:ba...
destination:symbo...
cutting

access

hgv

foot

sac_scale

name:af
lanes:backward
lanes:forward
reg_ref

bicycle

cycleway v
sidewalk

service

bridge

it -8B B « & @

Classification
Color
Date/Time

Attachment
Hidden

Relation Reference
Text Edit

Unigue Values
Uuid Generator
Value Map

Value Relation

_

layer =

@Help

Style -~

5. Click OK

</ Apply

6. Enter edit mode (if the roads layer is not already in edit mode)

7. Click on the Q& Identify Features 6]

8. Click on the same main road you

chose earlier

-

#® Cancel

You will now see that the oneway attribute has a checkbox next to it denoting True (checked) or Fa 1 se (unchecked).

5.3.4 Try Yourself:

Set a more appropriate form widget for

the highway field.

Answer

For the TYPE, there is obviously a limited amount of types that a road can be, and if you check the attribute table for
this layer, you’ll see that they are predefined.

1. Set the widget to Value Map and click Load Data from Layer.

2. Select roads in the Label dropdown and highway for both the Value and Description options:
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|2 | highway | QSiring ‘ String | 254

| R I P |

|° | | EERGeVRESEaARIE

[a I I

Attribute Edit Dialog "highway"

ms Line edit (¥ Editable
Classification || Label on top
ata Range

Unigue values
File name

Value map shown in the combo box.

Combo box with predefined items. Value is stored in the attribute

™ v
| ~ ~
& ~

Select data from atiributes in selected layer.

Enumeration
Immutable

Load Data from layer l [ Load Data from CSV file

Hidden

Checkbox Value Description

Text edit
Calendar 1 |

Layer
Value

Description

[ roads ;]

highway

View All

“
v

Value

Description

Value relation
UUID generator
Photo

Webview

Color

footway

footway

path

path

primary

primary

residential

residential

service

service

tertiary

tertiary

Remove Selected

el | [0k ]

3. Click OK three times.

4. If you use the Identify tool on a street now while edit mode is active, the dialog you get should look like this:

8006 Attributes - roads - -
osm_id 238808188
name Voortrek Street |
highway [ secondary 4]
waterway | NULL |
aerialway  NULL |
barrier 'NULL |
man_made ||
other_tags | "lanes'=>"2" a|

Cancel | (0K
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5.3.5 Try Yourself: Creating Test Data

You can also design your own custom form completely from scratch.
1. Create a simple point layer named test-data with two attributes:
¢ name (text)

* age (integer)

New GeoPackage Layer X

Database training_data.gpkg

Table name test-data

Geometry type Point >
Include Z dimension Include M values

EPSG:4326 - WGS 84 v | |
New Field
Name
Type 123 \Whole Number (integer) -

Maximum length

Fields List
Name Type Length
name text 80
age integer

w Advanced Options

Layer identifier  test-data
Layer description

Feature id column | fid
Geometry column |geometry

¥ Create a spatial index

©Help Ocancel QoK

2. Capture a few points on your new layer using the digitizing tools so that you have a little data to play with. You
should be presented with the default QGIS generated attribute capture form each time you capture a new point.

Note: You may need to disable Snapping if still enabled from earlier tasks.
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test-data - Feature Attributes X

fid Autogenerate a| v
name richard a
age 23 =

Ocance

5.3.6 Follow Along: Creating a New Form

Now we want to create our own custom form for the attribute data capture phase. To do this, you need to have QT
Designer installed (only needed for the person who creates the forms).
1. Start QT Designer.

2. In the dialog that appears, create a new dialog:

006 New Form

templates/torms
Dialog with Buttons Bottom

Dialog with Buttons Right
Dialog without Buttons
Main Window
Widget
Widgets
Cancel 0K
Embedded Design
Device: Nene
Screen Size: | Default size s
(¥ Show this Dialog on Startup
| Open.. | [ Recentw | | Close | [ Create |

3. Look for the Widget Box along the left of your screen (default). It contains an item called Line Edit.
4. Click and drag this item into your form. This creates a new Line Edit in the form.

5. With the new line edit element selected, you'll see its properties along the side of your screen (on the right by
default):
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10.
11.
12.

13.
14.

000

Property Editor

[Filter

lineEdit : QLineEdit

ar, = 7,

Praperty

Valug

lineEdit

-

enabled ™

» geometry [(80, 40), 113 x 21]

» sizePolicy [Expanding, Fixed, 0, 0]

»  minimumSize 0x0

» maximumSize 16777215 x 16777215

» sizelncrement 0x0

» baseSize 0x0
palette Inherited

» font A [Lucida Grande Ul, 13]
cursor | I1Beam
mouseTracking ™
focusPolicy StrongFocus
contextMenuPolicy | DefaultContextMenu
acceptDrops ™

» toolTip

b statusTip

» whatsThis

» accessibleName

» accessibleDescrip...
layoutDirection LeftToRight

autoFillBackground

styleSheet

» locale

English, SouthAfrica

p inputMethodHints ImhNone

\

» inputMask

b text
maxLength 32767
frame [21
echoMode Normal
cursorPosition 0

» alignment AlignLeft, AlignVCenter
dragEnabled ]
readOnly ]

p placeholderText

curanrifnvaShiles

| nniralMovaShile

Set its name to name.
Using the same approach, create a new Spin Box and set its name to age.

Add a Label with the text Add a New Person in a bold font (look in the object properties to find out how
to set this). Alternatively, you may want to set the title of the dialog itself (rather than adding a label).

Add a Label for your Line Edit and your Spin Box.
Arrange the elements to your own desire.
Click anywhere in your dialog.

Find the Lay Out in a Form Layout button (in a toolbar along the top edge of the screen, by default). This lays
out your dialog automatically.

Set the dialog’s maximum size (in its properties) to 200 (width) by 150 (height).

Your form should now look similar to this:
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8 -add_people.ui* |- [X

15. Save your new form as exercise_data/forms/add_people.ui

16. When it’s done saving, you can close Qf Designer

5.3.7 Follow Along: Associating the Form with Your Layer

1. Go back to QGIS
Double click the fest-data layer in the legend to access its properties.
Click on the Aftributes Form tab in the Layer Properties dialog

In the Attribute editor layout dropdown, select Provide ui-file.

wook wn

Click the ellipsis button and choose the add_people.ui file you just created:

Layer Properties - test-data | Attributes Form x

Q Provide ui-file ~ | @ | Show form on add feature (global settings) ~

G’ InFormation = Edit Ul |/home/qgis-user/forms/add_people.ui
Available widgets

2a v General
W\ Source ¥ Fields
fid ;
4 Al
& symbology name ias
___age | Comment
X Labels Relations .
- Other Widgets v/ Editable | | Labelon top
@B masks QML Widget
HTML Widget v Widget Type
. Diagrams
Text Edit -
Wp 3D View
Multiline
E Fields
prm .
|=1| Attributes Form
Joins w Constraints
L Auxiliary
0 storage Mot null
(;‘.G) Actions Unique
. Expression ~||€
. Display
- Expression description
& Rendering
Enforce expression constraint
Variables
_ v Defaults
H Metadata
Default value £
ﬁ Dependencies Prane

Apply default value on update

@Help Style ~ « Apply || % cancel

Legend

QGIS Server

-

6. Click OK on the Layer Properties dialog
7. Enter edit mode and capture a new point

8. When you do so, you will be presented with your custom dialog (instead of the generic one that QGIS usually
creates).
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9. If you click on one of your points using the Q& Identify Featwres t0] you can now bring up the form by right
clicking in the identify results window and choosing View Feature Form from the context menu.

10. If you are in edit mode for this layer, that context menu will show Edit Feature Form instead, and you can then
adjust the attributes in the new form even after initial capture.

5.3.8 In Conclusion

Using forms, you can make life easier for yourself when editing or creating data. By editing widget types or creating
an entirely new form from scratch, you can control the experience of someone who digitizes new data for that layer,
thereby minimizing misunderstandings and unnecessary errors.

5.3.9 Further Reading

If you completed the advanced section above and have knowledge of Python, you may want to check out this blog entry
about creating custom feature forms with Python logic, which allows advanced functions including data validation,
autocompletion, etc.

5.3.10 What’s Next?

Opening a form on identifying a feature is one of the standard actions that QGIS can perform. However, you can also
direct it to perform custom actions that you define. This is the subject of the next lesson.

5.4 Lesson: Actions

Now that you have seen a default action in the previous lesson, it is time to define your own actions.

An action is something that happens when you click on a feature. It can add a lot of extra functionality to your map,
allowing you to retrieve additional information about an object, for example. Assigning actions can add a whole new
dimension to your map!

The goal for this lesson: To learn how to add custom actions.

In this lesson you will use the school_property layer you created previously. The sample data include photos of each
of the three properties you digitized. What we are going to do is to associate each property with its image. Then we
will create an action that will open the image for a property when clicking on the property.

5.4.1 Follow Along: Add a Field for Images

The school_property layer has no way to associate an image with a property yet. First we will create a field for
this purpose.

1. Open the Layer Properties dialog.
2. Click on the Fields tab.
3. Toggle editing mode:
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Layer Properties - school_property | Fields

NE

d - 1Toggle editing mode t'pe Type name  Length Precision = Comment

‘:{:\? Source

1230 |id glonglong | Integer64 10 0 v

%" symbology

abc | name Qstring  String 80 0 v
€3 Labels

B Masks

- .
. [MELEIN S

W7 3D View
E 5 Fields

E Aktributes Form

1 4

Joins
s Auxiliary . @telp || style -  Japply | ®cancel || Jok |

4. Add a new column:

Layer Properties - school_property | Fields

If? ® (/] |E
New field |me Alias Type Type name Length Precision Comment

1220 |id glonglong | Integer64 10 0 v

(;’i Information

:{:\\ Source . :
: abc name Qstring String 80 0 v

%~ symbology
€= Labels
B Masks

. Diagrams

Ng 3D View

E g Fields

E Attributes Form

5. Enter the values below:
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Add Field

Name

Comment

Type

|image|

Text (string)

Provider type string

Length

il
-

% cancel | o OK |

6. After the field has been created, move to the Atributes Form tab and select the image field.

7. Set Widget Type to Attachment:

Layer Properties - school_property | Attributes Form x

G’ Information

‘:{:\} Source

¥ symbology

> .
" Diagrams

W# 3D View
ﬁ Fields

::E: Attributes For

Joins

L Auxiliary
&M Storage

«;@ Actions
- Display
Qj./ Rendering

Variables

l Metadata

ﬁ Dependencies
Legend

& qais server

8. Click OK in the Layer Properties dialog.

* | Available widgets

~ Other Widgets

v General

Alias
Comment
v| Editable

v Widget Type
Attachment

Path

Label on top

~ | @ || show form on add feature (global settings) ~

-

Default path |/home/tveite/Downloads/QGIS/QGISTrainin... || ... | €

Relative paths

Storage Mode

@ File paths
Directory paths

v Display Resource Path

v Display button to open File dialog

Filter

Use a hyperlink For document path (read-only)

-

</ Apply || % cancel oK

9. Use the Identify tool to click on one of the three features in the school_property layer.

Since you are still in edit mode, the dialog should be active and look like this:

180

Chapter 5. Module: Creating Vector Data



QGIS Training Manual

school_property - Feature Attributes .

Actions

id |2 |

name school campus

image

% cancel | &/ OK |

10. Click on the browse button (the ... next to the image field).

11. Select the path for your image. The images are in exercise_data/school_property_photos/
and are named the same as the features they should be associated with.

12. Click OK.
13. Associate all of the images with the correct features using this method.

14. Save your edits and exit edit mode.

5.4.2 Follow Along: Creating an Action

1. Open the Actions tab for the school_property layer, and click on the Ifl-l-ll:| Add anew action b0,

Layer Properties - school_property | Actions x

Q, ¥ Action List

"i Information Description Short Title Action  Capture Action Scopes On Notification Only when editable
‘?\_“\\ Source

% symbology

€ Labels

€O Masks

- N
a Diagrams

W# 3D View

E Fields

E Attributes Form

Joins
4 »

ﬂ Auxiliary Storage Lk Create Default Actions

Actions Add a new action
J » | show in Attribute Table

® Display _| @Help Style - «/ Apply || % Cancel

2. In the Add New Action dialog, enter the words Show Image into the Description field:
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Add New Action -~

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 3
| E Insert
Execute if notification matches

Enable only when editable

@Hel ¥ cancel
p L

What to do next varies according to your operating system, so choose the appropriate course to follow:

¢ Windows
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Click on the Type dropdown and choose Open.
e Ubuntu Linux

Under Action, write eog for the Gnome Image Viewer, or write display to use ImageMagick. Re-
member to put a space after the command!

* macOS
1. Click on the Type dropdown and choose Mac.
2. Under Action, write open. Remember to put a space after the command!
Now you can continue writing the command.

You want to open the image, and QGIS knows where the image is. All it needs to do is to tell the Action where
the image is.

3. Select image from the list:
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Add New Action i3

Type Generic - Capture output

Description |Mandatory description
Short Mame |Leave empty to use only icon
lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

v Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 eoq- [%imageS]

4 b
123 id

abc name

@Help % Cancel

4. Click the Insert field button. QGIS will add the phrase [$ "image" %] in the Action Text field.
5. Click the OK button to close the Add New Action dialog
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6. Click OK to close the Layer Properties dialog
Now it is time to test the new action:

1. Click on the school_property layer in the Layers panel so that it is highlighted.

. "@-\l‘- Run feature acti : .
2. Find the == Runteatureacion yytton (in the Antributes Toolbar).

3. Click on the down arrow to the right of this button. There is only one action defined for this layer so far, which
is the one you just created.

TN oo

4. Click the button itself to activate the tool.

5. Using this tool, click on any of the three school properties.

The image for that property should open.

5.4.3 Follow Along: Searching the Internet

Let’s say we are looking at the map and want to know more about the area that a farm is in. Suppose you know
nothing of the area in question and want to find general information about it. Your first impulse, considering that
you’re using a computer right now, would probably be to Google the name of the area. So let’s tell QGIS to do that
automatically for us!

1. Open the attribute table for the landuse layer.
We will be using the name field for each of our landuse areas to search Google.
2. Close the attribute table.
3. Go back to Actions in Layer Properties.
4. Click on the Create Default Actions button to add a number of pre-defined actions.

5. Remove all the actions but the Open URL action with the short name Search Web using the =

Remove the selected action by1¢ton below.
6. Double-click on the remaining action to edit it
7. Change the Description to Google Search, and remove the content of the Short Name field.
8. Make sure that Canvas is among the checked Action scopes.
What to do next varies according to your operating system, so choose the appropriate course to follow:
* Windows

Under Type, choose Open. This will tell Windows to open an Internet address in your default browser,
such as Internet Explorer.

¢ Ubuntu Linux

Under Action, write xdg—open. This will tell Ubuntu to open an Internet address in your default browser,
such as Chrome or Firefox.

¢ macOS

Under Action, write open. This will tell macOS to open an Internet address in your default browser,
such as Safari.

5.4. Lesson: Actions 185



QGIS Training Manual

Now you can continue writing the command

Whichever command you used above, you need to tell it which Internet address to open next. You want it to
visit Google, and to search for a phrase automatically.

Usually when you use Google, you enter your search phrase into the Google Search bar. But in this case, you
want your computer to do this for you. The way you tell Google to search for something (if you don’t want to
use its search bar directly) is by giving your Internet browser the address https://www.google.com/
search?gq=SEARCH_PHRASE, where SEARCH_PHRASE " is what you want to search for. Since we don’t
know what phrase to search for yet, we will just enter the first part (without the search phrase).

In the Action field, write https://www.google.com/search?g=. Remember to add a space after
your initial command before writing this in!

Now you want QGIS to tell the browser to tell Google to search for the value of name for any feature that you
could click on.

10. Select the name field.

11. Click Insert button:
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Edit Action -~

Type Generic - Capture output

Description |Google Search
Short Mame |Leave empty to use only icon

lcon

Action Scopes

Field Scope
Layer Scope
v Canvas

Feature Scope

Action Text

The action text defines what happens if the action is triggered.
The content depends on the type.

For the type Python the content should be python code
For other types it should be a file or application with optional parameters

1 xdg-open-http://www.google.com/search?q=[%name%]

1 b

| E Insert

Execute if notification matches || |

Enable only when editable

@Help % Cancel « OK

What this means is that QGIS is going to open the browser and send it to the address https://www.

google.com/search?g=[% "name" %]. [%$ "name" %] tells QGIS to use the contents of the
name field as the phrase to search for.
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So if, for example, the landuse area you click on is named Marloth Nature Reserve, QGIS is going to
send the browser to https://www.google.com/search?g=Marloth%20Nature%20Reserve,
which will cause your browser to visit Google, which will in turn search for “Marloth Nature Reserve”.

12. If you have not done so already, set everything up as explained above.
13. Click the OK button to close the Add New Action dialog
14. Click OK to close the Layer Properties dialog

Now to test the new action.

@ .
1. With the landuse layer active in the Layers panel, click on the down arrow to the right of the &1& Run feature action

button, and select the only action (Google Search) defined for this layer.

2. Click on any landuse area you can see on the map. Your browser will now open, and will start a Google search
for the place that is recorded as that area’s name value.

Note: If your action doesn’t work, check that everything was entered correctly; typos are common with this kind of
work!

5.4.4 Follow Along: Open a Webpage Directly in QGIS

Above, you’ve seen how to open a webpage in an external browser. There are some shortcomings with this approach
in that it adds an unknowable dependency — will the end-user have the software required to execute the action on
their system? As you’ve seen, they don’t necessarily even have the same kind of base command for the same kind
of action, if you don’t know which OS they will be using. With some OS versions, the above commands to open the
browser might not work at all. This could be an insurmountable problem.

However, QGIS sits on top of the incredibly powerful and versatile Qt library. Also, QGIS actions can be arbitrary,
tokenized (i.e. using variable information based on the contents of a field attribute) Python commands!

Now you will see how to use a python action to show a web page. It is the same general idea as opening a site in an
external browser, but it requires no browser on the user’s system since it uses the Qt QWebView class (which is a
webkit based html widget) to display the content in a pop-up window.

Let us use Wikipedia this time. So the URL you request will look like this:
https://wikipedia.org/wiki/SEARCH_PHRASE
To create the layer action:
1. Open the Layer Properties dialog and head over to the Actions tab.
2. Set up a new action using the following properties for the action:
e Type: Python
* Description: Wikipedia
e Scope: Feature, Canvas

e Action Text:

from ggis.PyQt.QtCore import QUrl
from ggis.PyQt.QtWebKitWidgets import QWebView

myWV = QWebView (None)
myWV.load (QUrl ('https://wikipedia.org/wiki/ [$name%] "))
myWV . show ()
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Edit Action X

Type Python - Capture output
Description |wikipedia

Short Name |Leave empty to use only icon

lcon

Action Scopes

Layer
| Feature
¥ Canvas

Field

Form

Action Text

The action text defines what happens if the action is triggered.

The content depends on the type.

For the type Python the content should be Python code, if the action is triggered from a button
widget embedded in a drag and drop designer Form, the form instance is exposed to Python as
the formvariable.

For other types it should be a File or application with optional parameters.

1 from-qgis.PyQt.QtCore-import -QuUrl

2 from-qgis.PyQt.QtWebKitWidgets import  QwWebView

3

4 myWV =-QWebView(None)

5 myWv.load(QUrl("https://wikipedia.org/wiki/[%name%]"'))

6 mywv.show()

7
1 #
123 *|| £ Insert

Execute if notification matches

Enable only when editable

@ Help © cancel QoK

There are a couple of things going on here:

* [$name%] will be replaced by the actual attribute value when the action is invoked (as before).

¢ The code simply creates a new QWebView instance, sets its URL, and then calls show () on it to make
it visible as a window on the user’s desktop.

You could also use this approach to display an image without requiring that the users have a particular image
viewer on their system.

3. Try to use the methods described above to load a Wikipedia page using the Wikipedia action you just created.
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5.4.5 In Conclusion
Actions allow you to give your map extra functionality, useful to the end-user who views the same map in QGIS. Due

to the fact that processes called can be shell commands for any operating system, as well as Python, the sky is the
limit in terms of the functions you could incorporate!

5.4.6 What’s Next?

Now that you’ve done all kinds of vector data creation, you will learn how to analyze the data to solve problems. That
is the topic of the next module.
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MODULE: VECTOR ANALYSIS

Now that you have edited a few features, you must want to know what else one can do with them. Having features
with attributes is nice, but when all is said and done, this doesn’t really tell you anything that a normal, non-GIS map
can’t.

The key advantage of a GIS is this: a GIS can answer questions.

For the next three modules, we’ll endeavor to answer a research question using GIS functions. For example, you are an
estate agent and you are looking for a residential property in Swellendam for clients who have the following criteria:

1. It needs to be in Swellendam.

2. It must be within reasonable driving distance of a school (say 1km).
3. It must be more than 100m squared in size.

4. Closer than 50m to a main road.

5. Closer than 500m to a restaurant.

Within the next few modules, we’ll harness the power of GIS analysis tools to locate suitable farm properties for this
new residential development.

6.1 Lesson: Reprojecting and Transforming Data

Let us talk about Coordinate Reference Systems (CRSs) again. We have touched on this briefly before, but haven’t
discussed what it means practically.

The goal for this lesson: To reproject and transform vector datasets.

6.1.1 Follow Along: Projections

The CRS that all the data, as well as the map itself are in right now is called WGS84. This is a very common
Geographic Coordinate System (GCS) for representing data. But there’s a problem, as we will see.

1. Save your current map

2. Then open the map of the world which you will find under exercise_data/world/world.ggs
3. Zoom in to South Africa by using the Zoom In tool
4

. Try setting a scale in the Scale field, which is in the Statusbar along the bottom of the screen. While over South
Africa, set this valueto 1: 5 000 000 (one to five million).

5. Pan around the map while keeping an eye on the Scale field

Notice the scale changing? That’s because you are moving away from the one point that you zoomed into at 1: 5
000 000, which was at the center of your screen. All around that point, the scale is different.
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To understand why, think about a globe of the Earth. It has lines running along it from North to South. These
longitude lines are far apart at the equator, but they meet at the poles.

In a GCS, you are working on this sphere, but your screen is flat. When you try to represent the sphere on a flat
surface, distortion occurs, similar to what would happen if you cut open a tennis ball and tried to flatten it out. What
this means on a map is that the longitude lines stay equally far apart from each other, even at the poles (where they
are supposed to meet). This means that, as you travel away from the equator on your map, the scale of the objects
that you see gets larger and larger. What this means for us, practically, is that there is no constant scale on our map!

To solve this, let’s use a Projected Coordinate System (PCS) instead. A PCS “projects” or converts the data in a way
that makes allowance for the scale change and corrects it. Therefore, to keep the scale constant, we should reproject
our data to use a PCS.

6.1.2 Follow Along: “On the Fly” Reprojection

By default, QGIS reprojects data “on the fly”. What this means is that even if the data itself is in another CRS, QGIS
can project it as if it were in a CRS of your choice.

You can change the CRS of the project by clicking on the 'E‘ Current projection hytton in the bottom right corner of
QGIS.

1. In the dialog that appears, type the word global into the Filter field. A few CRSs should appear in the
Predefined Reference Systems field below.

2. Select WGS 84 / NSIDC EASE-Grid 2.0 Global | EPSG:6933 entry by clicking on it, and then click OK.

Notice how the shape of South Africa changes. All projections work by changing the apparent shapes of objects
on Earth.

3. Zoomtoascaleof 1:5 000 000 again, as before.
4. Pan around the map.
Notice how the scale stays the same!
“On the fly” reprojection is also used for combining datasets that are in different CRSs.

1. Add another vector layer to your map which has the data for South Africa only. You will find it as
exercise_data/world/RSA.shp.

2. Loadit. A quick way to see its CRS is by hovering the mouse over the layer in the legend. It is EPSG: 3410.
What do you notice?

The layer is visible even if it has a different CRS from the continents one.

6.1.3 Follow Along: Saving a Dataset to Another CRS

Sometimes you need to export an existing dataset with another CRS. As we will see in the next lesson, if you need
to make distance calculations on layer, it is always better to have the layer in a projected coordinate system.

Be aware that the ‘on the fly’ reprojection is related to the project and not to single layers. This means that a layer
can have a different CRS from the project even if you see it in the correct position.

You can easily export the layer with another CRS.
1. Add the buildings dataset from training_data.gpkg
2. Right-click on the buildings layer in the Layers panel

3. Select Export » Save Features As... in the menu that appears. You will be shown the Save Vector Layer as...
dialog.

4. Click on the Browse button next to the File name field

192 Chapter 6. Module: Vector Analysis



QGIS Training Manual

5. Navigate to exercise_data/ and specify the name of the new layer as buildings_reprojected.
shp.

6. Change the value of the CRS. Only the recent CRSs used will be shown in the drop-down menu. Click on the
% Select projection tyytton next to the drop-down menu.

7. The Coordinate Reference System Selector dialog will appear. In its Filter field, search for 34S.
8. Select WGS 84 / UTM zone 34S | EPSG:32734 from the list

Coordinate Reference System Selector

select the coordinate reference system for the vector file. The data points will be transformed from the layer

coordinate reference system.

Filter | ©L 345

Recently used coordinate reference systems

Coordinate Reference System
WGS 84  UTM zone 345

Authority 1D

1
Coordinate reference systems of the world

EPSG:32734

r
Hide deprecated CRSs

il

wrdinate Reference System Authority 1D
RGRDC 2005/ UTM zone 345 EP5G:4062
WGS 72 [ UTM zone 345 EP5G:32334
WGS 72BE /| UTM zone 345 EP5G:32534

WGS 84 fUTM zone 345

EP5G:32734

[ C

Selected CRS WG5S 84 / UTM zone 345
- T -

Extent: 18.00, -80.00, 24.00, 0.00 N 9 oy
Projd: +proj=utm +zone=34 +south fl?-' - ,
+datum=WG584 +units=m +no_defs & g

. [@lHelp | | @cancel || Pok |

9. Leave the other options unchanged. The Save Vector Layer as... dialog now looks like this:
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Save Vector Layer as...

Format ESRI Shapefile

File name |ome/matteo/exercise_data/exercise_data/buildings_reprojected.shp &

Layer name
CRS EPSG:32734 - WGS 84 7 UTM zone 345 - ||
Encoding UTF-8 -

v | Add saved file to map

b Select fields to export and their export options
v Geometry

Geometry type Automatic =

» Extent (current: layer)
P Layer Options

P Custom Options

Help @ Cancel oK

10. Click OK

You can now compare the old and new projections of the layer and see that they are in two different CRS but they
are still overlapping.
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6.1.4 Follow Along: Creating Your Own Projection

There are many more projections than just those included in QGIS by default. You can also create your own projec-
tions.

1. Start a new map
2. Load the world/oceans. shp dataset

3. Go to Settings » Custom Projections... and you will see this dialog.

Custom Coordinate Reference System Definition x

v Define

You can define your own custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Format for specifying a CRS.

Name Parameters dha
=
Name
Format WKT (Recommended) -
Validate
Parameters
v Test

Use the text boxes below to test the CRS definition you are creating. Enter a coordinate where both the lat/long and the transformed result are known (for example by
reading off a map). Then press the calculate button to see if the CRS definition you are creating is accurate.

Geographic / WGS84 Destination CRS

Calculate

@Help Ocancel QoK

4. Click on the 5 Add new crs button to create a new projection
5. An interesting projection to use is called Van der Grinten I.Enter its name in the Name field.

This projection represents the Earth on a circular field instead of a rectangular one, as most other projections
do.

6. In Format, select WKT (Recommended)

7. Add the following string in the Parameters field:

(PROJCRS["unknown",
BASEGEOGCRS [ "unknown",
DATUM["unknown",
ELLIPSOID["unknown", 6371000,0,
LENGTHUNIT ["metre", 1,
ID["EPSG",9001]111,
PRIMEM|["Greenwich", O,
ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8901]11,
CONVERSION ["unknown",
METHOD ["Van Der Grinten"],
PARAMETER|["Longitude of natural origin", 0,

(continues on next page)
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ANGLEUNIT ["degree",0.0174532925199433],
ID["EPSG",8802]],
PARAMETER["False easting", 0,
LENGTHUNIT ["metre",1],
ID["EPSG",8806]],
PARAMETER["False northing", 0,
LENGTHUNIT ["metre",1],
ID["EPSG",8807]11,
CS[Cartesian, 2],
AXIS[" (E)",east,
ORDER[17],
LENGTHUNIT["metre", 1,
ID["EPSG", 9001111,
AXIS[" (N)",north,
ORDER[2],
LENGTHUNIT ["metre", 1,
ID["EPSG", 90011111

(continued from previous page)

Custom Coordinate Reference System Definition X

v Define

You can define your ewn custom Coordinate Reference System (CRS) here. The definition must conform to a WKT or Proj string Fermat for specifying a CRS.

Name Parameters o
Van der Grinten | PROJCRS["unknown", BASEGEOGCRS["unknown", DATUM["unknown" ELLIPSOID["unknown",6371000,0,LENGTHUNIT["metre”,1,ID[... -
Name Van der Grinten |
Format WKT (Recommended) -
PROJCRS["unknown", = Vvalidate
BASEGEOGCRS["unknown",
DATUM["unknown",
ELLIPSOID["unknown",6371000,0,
LENGTHUNIT["metre",1,
Parameters ID["EPSG",9001]]]],
PRIMEM["Greenwich",0,
ANGLEUNIT["degree",0.0174532925199433],
ID["EPSG",8901]]],
CONVERSION["unknown",
METHOD["Van Der Grinten"], -
» Test 1
@Help Ocancel QoK
8. Click OK

9. Click on the 2 Curent CRS byion at the right of the status bar to change the project CRS

10. Choose your newly defined projection (search for its name in the Filter field)

11. On applying this projection, the map will be reprojected thus:
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n *Untitled Project - QGIS 9e45223d42 [tm] = o x
Project Edit View Layer Settings Plugins Vector Raster Database Web Processing Help

 DERBRRRE [(rLLrHPRPALBBNR 4 -K-A-CEE#IS-0 0

A /BRAR-FDxgBoe "qAE% 2993 QAR 4a0- B KX L

Layers
clegwva-arn
Mo
7~
L]
Browser ‘ Layers |
| @ Type to locate (ctr+k) 1 legend entries removed Coortinate | 2652139.4502093) | scale | 1218427020 ‘-I & Magnifier | 100% 2] Rotation [0.0° [3][v] Render @ userao0o2s @

6.1.5 In Conclusion

Different projections are useful for different purposes. By choosing the correct projection, you can ensure that the
features on your map are being represented accurately.

6.1.6 Further Reading

Materials for the Advanced section of this lesson were taken from this article.

Read further information on Coordinate Reference Systems.

6.1.7 What’s Next?

In the next lesson you will learn how to analyze vector 